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ABOUT THE AUTHOR

“At last, we have someone who creates

breathtaking new images.”—Tony Corbell

Jennifer George owns and operates Jennifer George Photography
in San Diego, CA. She received her Masters degree from the Pro-
fessional Photographers of America (PPA) in only three years' time
and received her Photographic Craftsman degree the next year.
After winning the California Photographer of the Year Award in
2001 from Professional Photographers of California she was able
to travel across the state, sharing her award-winning portrait style
and inspiring others to tap into their creativity. Jennifer received
the Grand Premiere and First Place Awards at the Wedding and
Portrait Photographers International (WPPI) print competition in
2003, then won the gold-level Photographer of the Year Award
from PPA in 2005. She taught at the PPA Women in Photography
convention in 2004 and spoke and taught at the annual WPPI
convention on three separate occasions. Six of her works have
been selected for National Loan Exhibition by PPA. Additionally,
two of her prints were selected for the PPA display in Seoul,
Korea, in 2005.

Jennifer has quickly gained a reputation for her innovative,
heartfelt style and is passionate about reaching out to other pho-
tographers. She is a frequent guest lecturer at colleges, universi-
ties, photography affiliate organizations, and workshops in the
United States and abroad.

The Art of Pregnancy Photography is Jennifer's second publica-
tion. She joined with other photographers to produce A Mother’s
Touch (Zondervan Publishing House [a division of HarperCollins
Publishers] 1998), a book of photos and quotes from women on
motherhood. Her photos and statements have appeared in Pro-
fessional Photographer magazine, The Portrait Photographer’s Guide
to Posing (Bill Hurter; Amherst Media, 2004), The Portrait Pho-
tographer’s Handbook (Bill Hurter; Amherst Media, 2005), and Dig-
ital Photography for Children’s and Family Portraiture (2nd ed.,
Kathleen Hawkins; Amherst Media, 2008).

In an interview in The Portrait Photographer’s Guide to Posing,
Jennifer said, “I push myself creatively in order to create things
my clients have never seen before.” Jennifer also explains that her
signature style includes the use of body makeup and skin tone
changes because she is enthralled with the idea that who we are
is much more than skin deep, and it doesn’t matter what color you
are on the outside. She says, “It is the soul underneath that is so
beautiful.”

Jennifer teaches other photographers to cultivate the techni-
cal skills they need to enhance their images. However, she
strongly feels that photography has moved away from a techni-
cal skill and into the realm of accepted creative art. She says,
“Albert Einstein said that creativity is more important than knowl-
edge. All the knowledge in the world will never allow you to touch
others with emotions and to touch their soul—that’s the role of
creativity.”
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next fifteen years—at a minimum. More and more photographers are seeing

maternity photography as a natural evolution for wedding photographers

who want to continue the relationship they have already established with their
clients.
M

aternity sessions can result in exquisite images. Capturing the woman at

this remarkable stage in her life sets this type of portrait photography apart
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Left—There are times when all the elements
come together in a split second and you have the
opportunity to capture an amazing moment. This
beautiful family was close and tender with each
other; only slight refinements to the pose were
required to compose the story. This image wag
created in the studio using window light. A black
panel was used at camera left to deepen the shad-
ows. The portrait was captured with a Fuji FinePix
52 Pro camera at '/so second at f/4.0 with an 150
of 400. After the image was retouched in Photo-
shop, it was enhanced with the Nik Color Efex Pro
2.0 Midnight filter. Facing Page—(reating 3
beautiful image is simple when you understand
light. Creating this image required only a large
window, some fabric, and directing the subjects
into a natural pose. The couple was posed atop
several backdrops and fabric placed on the floor,
The light came from a large sliding glass door in
the living room of their home. This image was
captured on a Fuji FinePix S3 Pro digital camera
with a Tamron SPAF Aspherical XR Di LD 28-75mm
f/2.8 lens. The ISO was 400, and a shutter speed
of '/s0 second and aperture of f/4.8 were selected.
The image was slightly retouched in Photoshop
and then enhanced with Nik's Midnight filter.






from the rest. This is an opportunity for the portrait photographer to utilize

all of their technical and artistic skills to create dramatic to luxurious images,
depending on the client’s personality and preference. None of these sessions
or images will ever be called “typical.”

The time is finally right for maternity portraiture. Photographers can use
Adobe Photoshop and a host of Photoshop-compatible plug-ins to retouch
stretch marks and blemishes quickly and easily and achieve greater creative
and artistic freedom. From slimming areas of a subject to the fantasy approach
of placing the newborn baby in the image of the pregnant mother, to con-

verting color images to black & white, anything is possible!

ABOUT THIS BOOK

The Art of Pregnancy Photography was written for the intermediate to ad-
vanced photographer who wants to add pregnancy photography to his or her
repertoire. While many “how-to” books teach the basic technical information
required to conduct a photo session, this book explores maternity photogra-
phy from a conceptual and artistic point of view. Readers are encouraged to
think about the location of the session, what props and fabrics will best en-
hance the images, how to pose the subject and create an effective composi-
tion, how to create dimension and flatter the subject’s form with light, and
how to apply creative effects to the portraits to take your artistry to the next
level. The book also looks closely at the importance of developing your rela-
tionship with your subject. It is essential that photographers understand that
helping the pregnant woman relax and feel beautiful is just as important to a
successful shoot as setting up flattering lighting. Each chapter of the book will
explore the elements that must be considered to conduct an extraordinary,
artistic, and rewarding maternity portrait session.
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Left—It is a privilege for photographers to wit-
ness and capture tender moments like this. Hay-
ing the right tools and knowledge makes all the
difference. This couple was lying by their bedroom
window in an area propped with fabrics. Placing
them in the right light produced the form and
depth seen in the portrait. The image was cap-
tured on a Fuji FinePix S3 Pro camera with a Tam-
ron 28-74mm f/2.8 lens and settings of f/4.8 and
1/90 second at an ISO setting of 400. The image
was converted to black & white with the Kubota
Artistic Actions Vol. Two New B&W action, and the
edges were darkened with Kubota’s Edge Burner
action. (The actions are available at www.Kubo-
talmageTools.com.) Right—Working with chil-
dren can be rewarding when you understand what
they respond to and don't respond to. This active
little boy was more willing to pose with the right
directions. This window light image was captured
with a Nikon D2x and Tamron 28-75mm f/2.8
lens. The exposure was captured at an ISO of 400,
a shutter speed of 1/125, and an aperture of
f/5.3. After the image was retouched in Photo-
shop, it was enhanced with Nik's Midnight filter.



P CLIENT TESTIMONIAL
“Being photographed pregnant was
empowering. I felt gorgeous.

Simple lighting and sumptuous fabrics can be
used to create heirloom images in the subjects’
home or in the studio.

Absolutely gorgeous!”
—Rachel P.

1. PREPARING FOR THE SESSION

onducting a pre-session consultation will allow you to develop a rapport

with your client and make key decisions about how the portrait session
will unfold. This is the time to select a location for the portrait session, set a
date and time, discuss clothing and makeup options, and share a few success
stories from your previous pregnancy sessions. This is the perfect time to as-
sure your client that a maternity session can be more than a means to cap-
turing a moment in time—it can also be an opportunity to create artful
images that depict your client not as clumsy and large but graceful and beau-
tiful. When a woman contacts you to book a session, offer to conduct the
consultation in her home, as this may be more convenient—and more com-

fortable—for the client.

LOCATION

Most photographers don’t put a great deal of thought into selecting a loca-
tion for their client’s portrait session, but in pregnancy photography, choos-
ing the location can be one of the most important decisions the photographer
and client make.

Home vs. Studio. Most portrait clients come to the studio to be pho-
tographed. However, for a maternity client, the best location for the session
will likely be her home. In maternity portraiture, the subject’s comfort is
more critical than it is with any other demographic. Pregnancy causes many
changes in a woman’s body. Not only does the abdomen become enlarged,
shifting the woman’s center of gravity to her middle, but she may also be
coping with an aching back and knees from carrying the extra weight, diffi-
culty breathing from the growing baby pushing on her chest cavity, and hip
pain from the stretching of ligaments as her delivery date approaches.

Working in your subject’s home will save her the trouble of having to
travel. She will also benefit from having more clothing choices at hand and
the ability to change in the comfort of her own bedroom or bathroom.

There are many advantages for the photographer in conducting a session
at the subject’s home as well. Window lighting is one of the best lighting sce-
narios for portraiture; the light is full, soft, and luminous—and chances are,
your client’s home will offer a variety of effective window light options. Also,
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it m
trimester to move around, and having a bed to photograph her on can ofter

ay be difficult for a pregnant woman nearing the end of her third
relief for her aching back and hip joints. (Note that most master bedrooms
have the largest bed in the home and a large window to work with.) As the
subject relaxes and you dole out praise, you will see a look of calm and seren
ity come over her.

If you’re conducting the consultation in your client’s home, you’ll want to
determine which rooms will provide the best window light opportunities,

whether it’s okay to move the furniture, and any other issues that will impact

the session. You can also sell your client on the above-mentioned benefits of

conducting the session in her home.

On the other hand, there will be times when the studio is the best choice

for the session. In some cases, the portraits are being created as a gift for the

baby’s father, and the woman may have trouble scheduling a session when her

significant other is not at home. The studio will also likely be the best choice

for the session if the client desires high key or low key images.

Shooting from a higher perspective in the sub-
jects” bedroom allowed for the beautiful presen-

tation shown in the final image.



This pair of images shows once again how a few

simple tools and props plus great window light
can be used to your advantage when creating an

image in your subjects’ home.

SCHEDULING THE SESSION

Don’t forget to determine the client’s due date, and try to book the session

as close to that date as possible. Many photographers feel that it is best to
photograph the mother about midway through the eighth month. At this

point in the pregnancy, the mother is still mobile and the abdomen is close
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A good way to instruct a couple or group is to set
the anchor person in place first, then role-play
the second position. With a group, this is a good
way for the other subjects to see what you are
trying to achieve before they try to get into place.

tion of the light, and where the subject should stand, sit, or lie down will

help to build their trust in you. Giving a brief overview contributes to their

understanding and support for your idea.

BE ENCOURAGING

A woman in the late stages of her pregnancy will need lots of encouragement.
From the moment you first meet the subject, take note of the positive as-
pects of her appearance and pay her compliments. This will help build her
confidence, which, in turn, will help you in posing her and composing the
image later in the session. For example, if your subject has bright blue eyes,
compose an image that brings the viewer’s attention to her face. A woman
with a tiny figure can do several poses standing, while one with extra weight
may have to do most lying down.

When it’s time to move on to the posing, there are a variety of ways to en-
sure a successful, flattering pose. The various strategies will be covered in de-
tail below.

Show and Tell. To evoke the emotion you are looking for, talk to your
subjects about your creative vision for the images. Like a movie director, you
will have to prompt the subject to express the emotion you want to show.
Calmly give the woman several verbal cues regarding the emotion, all the

while watching for small nuances that will help to keep the emotion real. If
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you are telling a mother to relax and be serene, for instance, make sure that
her shoulders are not held too high or rigid.

When you direct the subject, physically show them where and how to pose.
Step back and let them try your pose. Once you walk back to the camera
arca, refine the pose verbally and by demonstrating with your hands.

Quiet Encouragement. With pregnancy photography, the goal is to de-
pict the mother’s beauty and nurturing qualities. To evoke this mood, you
will want to maintain a calm and quiet demeanor. Then, simply connect with
your client using your tone of voice and posture to elicit the expression you
want. By keeping the tone of the session low key, the subject can engage in
her innermost thoughts.

Candid Moments. Some subjects may almost intuitively present them-
selves in a flattering way. When the moment is right, simply capture a series
of images of the mom being “in the moment.”

Whatever your approach, remember that your client cannot see what you
are seeing through the camera. Be sure to describe the beautiful scene, com-
ment on how flattering the lighting is, and express how well the fabric en-

hances her skin tone. Paint a picture with your words, all the while instilling

confidence.

These candid images show a tender moment be-
tween the pregnant mom and her child.

Ed



The client had a very clear vision of the images

she wanted, and after discussing her concept and
learning about her family situation, the client’s
living room was selected as the best location for
the session. A thin diffusion fabric clamped over
the window provided privacy and created soft
window light similar to the light quality output
by a softbox. To soften the lines, add interest,
and create a more modest image, brown and gold
tulle was wrapped around the woman. The fin-
ished image was one not envisioned by the client
but developed by moving around the client during
the session.

PHOTOGRAPHING NUDE SUBJECTS

Working with a nude subject presents several challenges for all photographers,

male or female. Before beginning the session, make sure you’ve cultivated a
comfortable relationship with the subject. Also, be sure that you fully un-
derstand what she wants to achieve during the session and what she is com-
fortable with. Usually it is the client who wants the nude images, and so she
will be fairly comfortable with posing.

Next, you will need to determine the best location for the session. Keep in
mind that nude portraits taken at the woman’s home will improve her com-

fort level

and yours as well. As discussed earlier, the comfort of the woman
is imperative to the quality of the finished images. The emotion and realism
depicted in a nude portrait is directly related to the subject’s peace of mind.
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Working with an Assistant. Having an assistant on hand when working
with nude subjects is a good idea for female photographers, and for the male
photographer, a female assistant is a necessity. Your assistant can hold reflec
tors, drape fabric, and even help dress the subject.

Use Verbal Directions. It is important to use verbal instructions and not
touch the subject to direct the pose. For both male and female photogra
phers, keep a appropriate distance from the subject, relying only on verbal di
rections. Having a strong foundation of different poses that work in the nude
will move the session along and relax the subject.

Watch the Details. While capturing the image, be sure to keep an eye on

the details. The smallest mistake in positioning the subject can ruin the abil

Left—With the aid of an assistant, this “nude”
maternity image was created at the subject’s
home. Below—Never touch a nude subject when
helping them pose. Demonstrating the pose or
simply providing verbal instructions is a more pro-

fessional option.




Top—Asking the young sibling, “Can you hear the
baby?” and having them listen to Mom’s tummy
can produce a whimsical expression. Bottom—
Terrible twos are always difficult, and sometimes
the only thing you can do is to reign the toddler
in with the parent’s help.

ity to use the image. Take special care to ensure that areas of the body you

do not wish to show are covered by the hands or the position of the legs.
Consider using fabrics of varying weights and textures—or perhaps a robe.
These options can provide the required coverage and a dose of texture in the

image.

CONNECTING WITH CHILDREN

Increasing Your Odds. When your client’s children are to take part in a por-
trait session, there are a few tips you can use to increase your odds of creat-
ing great, salable images. At your first opportunity, get down to their eye
level, introduce yourself, and talk directly to them. Start off with happy,
friendly, but very calm conversation. Your behavior will set the tone of the ses-
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sion for the child. Next, let the child watch you set up the studio equipment

while being held in the arms of a parent.

When it’s time to begin photographing a mother-and-child portrait, re-
member that keeping the child close to mom will foster the feeling of pro-
tection. Step back and let the child interact with Mom naturally, while you
quietly capture those moments.

Eliciting Expressions. Capturing great expressions when photographing
children takes practice and patience. We all should be able to hold a squeaky
toy, tell a joke, or just act silly to get a big smile. The hard part is when you
want something thoughtful or just plain adorable.

Sometimes the best images happen when you stay calm, just let the sub-
jects be themselves, and capture the moment. Working in the home can be
advantageous when small children are a part of the session—babies and tod-
dlers are always more at case in the familiar surroundings of their homes.
Working on their turf can allow you to capture calm, sweet, and tranquil
expressions.

Whether it’s fate, the temperament of the child, the rclationship between
the child and parent, or the baby is sick or teething or Just not feeling well,
there will be times when nothing you try will help you to get the child to co-
operate and reward you with great expressions. In those situations, be flexi-
ble—and if need be, stop the session and try it another time. It would be
prudent, however, to hand the child off to the father for a few minutes while
you quickly capture a few images of the mother by herself, as you may not get
the chance again.

20 THE ART OF PREGNANCY PHOTOGRAPHY

Left—Sometimes having the child touch or lis-
ten to their mom’s tummy makes for a great, ex-
pressive image. The little girl in this portrait
appears hesitant, not sure about all this, but
wanting to be close to mom. Right—For the
young sibling, Mom’s pregnancy may not be the
best time. In this image, the child's expression
sends a clear message about her take on the preg-
nancy. Conversely, the mom’s expression conveys
her contented state of mind. Facing page—Keep-
ing the child close to Mom and Dad will ensure a
calm, secure child.






3. PROPS, FABRICS, AND BACKGROUNDS

regnancy is an important stage in the human experience, and it should

be the goal of the photographer to do more than simply document this

that «

}‘h.}\c of the \lll‘]t'\[‘\ life. It should be vour ;1<I.I] Lo create portraits

press the subject’s mood, her nurturing qualities, and the quiet anticipatio

Left—It's easy to create romantic and fantasy
3ges whe rporating beautiful, richly colol
i fabrics in your portraits. Above

abrics are the simplest and m(
ippropriate additions to maternity portrai
Keeping props simple allows the viewer to fo
their attention on the focal point of the image

the radant subject




Top—Selecting fabrics that harmonized with the
subjects’ skin tones and arranging them for the
clients to lie on provided a great base for the
image. Next, a background with the same tones
was added. These simple steps can add tremen-
dous impact to the image. Above—Selecting fab-
rics in the same color family keep the viewer
focused on the reflective, nurturing mood exhib-
ited by the subject.

of the birth. The portraits should have a storytelling quality and should be
free from objects that date the image.

In this chapter, we’ll take a look at some props, fabrics, and backgrounds
that work well for pregnancy portraiture and add interest in the portrait with-

out detracting from the viewer’s focus on the subject.

PROPS

Props have been used by photographers for over a century. Unfortunately,
photographers can become so enamored with the overuse of props that the
main objective of the image is lost. Props should always be used to enhance
the image and should never distract the viewer’s attention from the subject.
Again, simple is better when adding any element to an image, and it is espe-
cially true when using props.

Flowers are one of the most suitable props for maternity portraits. They are
associated with feminine beauty and also symbolize growth and new begin-
nings. Having several types and shades of silk flowers on hand is a quick and
casy way to add interest in an image.

Antique furniture and other objects that hold sentimental value for the
subject may also be considered, so long as the objects do not date the image.
Keep in mind that any furniture incorporated in the portrait should be darker
than the subject and should not reflect the light. A quick visual scan of the

overall scene should help you to identify and remove any distracting elements.
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FABRICS

['here are thousands of fabrics that arc¢ thin,

available today, but only those

lightweight, and have texture will work well as attire for your subject. Some

of the most effective fabrics for draping over and around the human form

are gauze, tulle, muslin, silk, crepe, stretch velvet, and chiffon. In the past, the

color selection available for each of these fabric types was rather limited
available in the traditional beige but in numerous

Today, muslin is not just
beyvond the fabric

colors too. For unique colors and textures in fabrics, look

stores and investigate upholstery shops With the wide variety of fabrics avail

able, your options are limited only by your imagination

Gauze. In the right-hand image on the facing page, the mom was W rapped

in moss green gauze, which harmonized beautifully with the bac kground and

flowers. The fabric was wrapped tightly around her to show off her small fig

ure and the perfect shape of her midrift

Tulle. If you plan to invest in only one type of fabric, tulle would be your

best bet. Tulle is a soft, net-like material that is traditionally used for making

wedding veils and dresses. It is also incredibly inexpensive and comes in a

wide array of colors

Because it is lightweight and thin, tulle is pertect for wrapping around the

body. It can also be used to add dimension on the set. Randomly spread the

tulle in uneven horizontal lines from the camera view. The tulle should cre

ate an undulating line to enhance the sense of depth in the image, as is shown

in the left-hand image below

in be used to drape the subject’s body, byt
rlook the option of using it to add di-
the overall image. The left image

effe

t of covering a bed in mounds of

ng fabrics. The right image shows how drap-

fabric across the subject added interest
i a leading line that draws the viewers
he subject’s face.




The poses selected for these subjects were iden-
tical, but the different fabrics used in the images

create two very different moods in the portraits.

Tulle can also be used to cover or create transition points in an image.

Placing tulle at the point where the background and floor meet, for example,
can give a finished look to the image. Dark tulle can be used to form a natu-
ral vignette around the edges of the image area. With the subject lying down,
use the tulle along all the image edges to draw the viewer’s eye directly to the

subject.

BACKGROUNDS

By layering traditional canvas or muslin backgrounds with an interesting, tex-
tured fabric clamped over the backdrop, you can create depth and interest in
the portrait and create enhanced mood and dimensionality. Make sure that
any fabrics to be added to the portrait complement the subject’s hair and skin
tones and harmonize with the subject’s clothing and any props. Once the
background fabrics are chosen, you can add supplementary fabrics of similar
shades, draping them over the background and using them to vignette the

subject.
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Upholstery fabrics, many of which are patterned and /or textured, though
too stiff and heavy for use in draping the client, are perfect for creating an in
teresting background. Jacquards and other fabrics in botanical prints can work

well for maternity portraits. Alternatively, a 3x4-foot or larger throw blanket

or rug can be used as an interesting background.

P CLIENT TESTIMONIAL

“The joy I felt within my soul for nine
months was captured that day with a

photograph, and it will stay with me

forever.”

—Shawna M.

Top and bottom—An advantage to working in
the client’s home is that their personal belong-
ings are at hand and can be easily added to the
portrait. Facing page—A simple tapestry was at-
tached to the existing backdrop using clamps in
order to create an interesting, textural backdrop
for this beautiful subject. To widen the area
behind the subject, tulle was used on the left side
of the image.













creasing societal appreciation of the beauty of the pregnant female form, we
also see motherhood as a time of beauty. You might wish to convey any of
these moods or feelings in your portrait. This time in a woman’s life is fleet
ing and very different from any other stage, and it is a privilege to record it

Make it your goal to capture genuine emotion during the shoot

THE BASIC POSE

A good pose is one that is flattering to the subject and provocative to the
viewer. There are many poses—sitting, standing, or lying—that can casily
meet this goal

Standing. Photographers always seem to first tackle photographing a preg

nant woman by having her stand upright. The assumption is that if she sits,

A good pose is one that flatters the subject and
provocative to the viewer. The details of the

approach used to create this portrait are

itlined on page 31.
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Left—Y

fer t begin the portrait se with a standing
s a good

optior The image was created J$1ing a single Lhight

and a reflector. The mom was asked to turn her
body toward the main light and place her left had
at the upper area of her tummy and her right had
at the lower area. Her chin was angled toward her
near shoulder. The intimate feel of this image is
due in part to the fact that the subject’s gaze is
not directed at the viewer; creating a profile of
the face or having the subject look at the camera

would produce a different look.

the viewer will not fully see the developed midntt. While a standing pose can
be a good place to start your session, you may find that the design and flow
of the image i1s most difficult with a single standing subject than with mulu
ple clients or a seated or lying pose

An image of the mother alone will be more dynamic if you take the time
to consider the best-possible placement of the hands, arms, and face.

In the image on the facing page, the mother’s arms wrap around and hold
her tummy, and she looks away with a thoughtful expression on her face.
Note the serenity and poise that is conveyed by the subject’s stance. The por
trait shows the subject’s strength and contentment. To create this mood, the
subject’s body was turned a few degrees away from the camera. She then
turned her upper body toward the camera and turned her face toward the
light. The position of her hands implies a sense of protection. By turning her
body slightly away from the direction of her feet, a simming effect was pro
duced. Additionally, turning her face away from the direction of her body
produced the desired S curve in the image. (For more on S curves and their

role in portrait design, see chapter 5.)
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Laying. The mother-to-be must be portrayed in the most relaxed, beau
tiful manner possible. When the mother is relaxed and surround by props
like soft pillows and beautiful fabrics, you can capture something that tran
scends conventional pregnancy photos. In the past, many pregnancy }‘“"“"m\
were taken with the mother-to-be in a standing position with the focus pri
marilv on her midriff. However, that isn’t necessarily the most comfortable
or aesthetically pleasing position for the subject. One of the most beautiful

ways to photograph the mother is with her lying down in such a position that

the woman becomes more relaxed and serene. From a technical viewpoint,

her body is more elongated and appears thinner

Photographing a client in a lying pose elongates
her body and makes her more comfortable. It's 5

1n-win situation.




4 ting the gaze

When posing the subjects, directing
your subjects can help tell the story. Here the
mother and the older sibling are looking ¢

future as a

gether, as if they are looking to the future

loving and supportive family.

Create your scene with beautiful fabrics in colors that complement the sub-

ject. Then have her lie down in the middle of a bed or on the floor (note that
it will be easier for your late-pregnancy clients to get up from the bed than
from the floor). Place her legs in a slight bend, with her arms relaxed and her
hands focused on her pregnancy.

Good posing of the hands is critical, as the hands express emotion. How
and where you pose the hands can make an immense difference in the over-

all quality of the pose and the message you are trying to convey in the image.
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['he hands can speak volumes about
the love the mother has for the l‘.ll‘\,
and hands touching between a couple
tell about their shared love and antici-
pation. Additionally, the position of
the hands, or the leading lines formed
when a couple joins hands, can create
the needed compositional elements
that add polish, guide the viewer’s
gaze through the image, and create a
dynamic feel in the image.

Making the posing of the hands
look natural can be difficult for some
subjects and photographers. One casy
method is to have the hands gently
holding on to something. The mother
can gently grasp the edge of the fabric
she is draped in, or hold a bouquet of

flowers, or simply rest them on her tummy. M

ake sure her hands are not po

sitioned in the center of her tummy area but are placed side to side or top to

bottom. If the mom’s hands look unnatural

her tummy or let go of the object she is holding for

afew seconds, then place
the hands back. Many times this will result in

amore natural look. There will
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» ask her to take her hands off of

Having the hands posed around the baby-to-be
conveys a sense of protection and nurturing. In
an image of the hands and tummy, an interesting
contrast is formed between the mature adult

hands and the anticipation of new life.



A standing pose is not your only option for pos
ing your pregnant subject. As shown here, a
seated pose can be elegant—and it may actually
provide your client some relief from an aching

back or knees.

be times, however, when you will have to demonstrate with your own hands
the position you want with the fingers in and the placement you are secking.

Keep in mind that a flattering hand pose is one in which the fingers are
spread slightly apart and bent away from the camera. Avoid having the back
of the hand squarely pointed at the camera. Also note that the palm should
never be faced toward the camera. If a hand is held away from the body, have
the middle finger bent slightly more than the other fingers. This position is
used by ballet dancers when the hand is held away from the body, and it pro
duces a graceful look.

You can capture the image with the camera positioned by the feet or the
head; either perspective can result in a breathtaking presentation

Seated. By having your scated subject posed with her back straightened,

you can present a full view of the mature pregnancy. In the image below, the

mother is beautifully portrayed as she sits with her legs bent and to the side.




The carefully designed lighting setup cast more illumination on the mother’s

left side, leaving part of her form in shadow. This allows for a slim, smooth
presentation of the body. Turning the subject’s head to the side brought her
striking profile into view. With her eyes closed, a sense of calm and serenity

was achieved.

PERSPECTIVE

To create the dramatic perspective, try photographing the subject from sev-
eral angles. The simplest change is to shoot from a lower camera angle. Once
you have the mother in a lying position, drop the camera down to right above
her head level. Take care to arrange her body in a flattering pose, with knees
slightly bent, hands on the body, and head at a tilt. Looking through the
viewfinder, make sure lines of the body lead the viewer’s gaze from the left
side of the image, to and across the graceful lines of the subject’s body, and
to the other side of the frame.

You can also consider creating an image from above the subject. When the
mother or couple is sitting down, stand directly above her or use a ladder to
get a fresh perspective. This viewpoint can slim the subject and make her
midriff the focal point of the shot. Adding dramatic lighting from a single
source so that the light cascades down the side of the subject can create a
calm, quiet mood in the image.

You can also capture an image that shows the mother’s perspective. By
standing behind her and photographing over her shoulder, you can capture
her hands—or the couple’s hands if you’re photographing the mom and
dad—around the tummy.

CORRECTIVE TECHNIQUES

Every once in a while you will need to photograph a mother who has gained
more weight than she would have liked. To flatter the subject’s face, select a

pose and camera perspective that allows her to lift her head and push her chin
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Left—This image of a couple has a unusga| f,

as the point of view is from above "a"eling doeel
the embracing couple. Facing page‘Hm:
unusual angle, from the top of the Mother dow:

creates an interesting and artistic Perspective j
the image. i







very slightly forward. Capturing the image from above will also help to down
play the double chin and give her a regal look

As many pregnant women put on weight, they become increasingly self
conscious about the size of their upper arms and thighs. To ensure a slimmer
presentation, have your subject position her upper arms slightly away from
her body, not pressing against her side. Providing a little space between the
knees will visually slim the thighs

Consider using fabrics to hide or reduce the apparent width of the arm or

legs. Remember that while tulle is perfect for hiding imperfections, it should

not be used to completely cover the subject’s skin.
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Left—The lines of the mother's and daughter's
bodies form undulating lines that draw your ey
across the image frame. Facing page—Ffor a very
dramatic image, move to a nontraditional posi-
tion. Here, capturing the image from above, plus
having the mother’s face follow the line of hef
body, created an unexpected image.






Lighting your overweight subject from one side will visually slim the body

and face. as the eve will be drawn to the well illuminated areas of her form

and will not linger on the shadow areas.

POSING COUPLES

Photographing the mother and dad together is one of the most rewarding as
pects of creating maternity portraits. The couple’s joy, love, and anticipation
is intoxicating—especially with the first child. The portrait session allows you
to capture an artistic representation of their love and union.

There are actually several ways to effectively pose the couple. You might
start by having the mother standing, and simply have the father wrap his arms
around her from behind. The camera angle can be from the front or side.
This pose will work best if the father is taller than the mother. For a traditional
look, have the father stand beside the mother, with one arm around her back
and the other hand placed on her belly and meeting her hand.

You can also take the opportunity to create artfully styled images of the

couple lying down. There are many advantages to selecting a lying pose. This

An image of the father and the tummy beautifully
illustrates the emotional connection the father
has with the baby.
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Top—Note the way that placing father’s hands
on the mother’s tummy creates a connection be
tween the couple and emphasizes his connection
with his child, as well. Bottom—In this sweet
image of the father kissing the mother’s tummy
the story is about the baby and dad, and the
mother becomes the “prop” or accessory to the
image. This image was simple to light, with a
large sliding glass door in the couple’s dinir

room area. Notice the position of the couple’s
hands, touching in a loving way. The physica
connection is important to the overall feeling o

the image.

position is more comfortable for the mother, of course, but it can be relax

ing to the father as well. Many fathers are not initially agrecable to being pho-
tographed. Once you get the couple to lic down together, the father usually
relaxes a great deal and takes direction well. In this pose, it is casy for the fa-
ther to wrap himself around the mother. In this position, the dad illustrates
his role of protector and supporter of the mother and child. He can place his

hands on her tummy, and if he’s feeling a little camera shy, he can nestle his
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i ‘lose avier subiject can lift his
head next to the mother’s with his eyes closed. A heavier subjec

chin to reduce the “double chin” look.

[f you are photographing a man and woman who are not comfortable w ith
the idea of lying down, you can use a scated pose to depict the feeling of
shared intimacv. Start with the mother seated, with her knees turned at an
angle to the camera. Next, have the father sit behind and slightly to the side
ul‘\llw mother, with his knees apart so that she can nestle into him. Be sure
that the mom is not blocking the father’s face. Have dad wrap his arms
around the mother and gently place his hands on her belly, arms, or hands

‘ » 1ety than does
While the seating pose can work in a pinch, it allows for less variet

a lying pose

» START WITH THE OUTFITS
d especially the fa-
ple portraits of the
they selected for the

more comfortable,

eative shots using

Left—An embracing couple is a wonderful way to
tell the story of the anticipation the parents have
for the arriving baby. Here the father is taking on
the role of protector with his arms around the
mother and hands on her tummy. Right—A con-
nection between the couple speaks volumes to
the viewer. The couple here are simply making eye
contact, but this simple look tells us so much

about their relationship and love.



In this image, the mother’s hand is gently placed

on her husband’s head, and his hand reaches up
to rest on her forearm. With the couple’s son
leaning on the father, the whole image conveys a
warm feeling of family togetherness. If you look
closely at the image you will also notice a series
of triangle patterns through the arms and heads.
The repeating patterns give the image a feeling of

harmony.

Another favorite pose for couples is an image of the baby-to-be with the
father. This pose allows you to showcase the relationship between the father
and baby in a way that including a fuller view of the mother does not ac-
complish. Adding an older sibling or siblings to the daddy-and-tummy pose
can also document the family dynamics and show the family members’ sense
of joy and anticipation.

While the subject is the pregnancy, evidence of the mother is very impor-
tant even with the father or siblings in the picture. By having her hands touch-
ing her belly or the other subject, you will create a loving and affectionate
mood.

Including the children will often make for a cheerful, fun image. How-
ever, including kids in any portrait session presents some unique challenges.
We'll review some strategies for working with children later in this chapter.

Coaxing Dad. Some fathers are resistant to the idea of participating in
the session. This is another benefit to conducting the session in the subject’s
home, as the father won’t have to be coaxed into going to the studio. Despite
their hesitation, fathers surprisingly turn out to be one of the biggest enthu-
siasts once you get them involved. Start with asking the father to be your

“helper,” getting him actively involved in the photographic process before
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1 ; : S C : ith everything from
you put him in front of the camera. Fathers can help with everything ‘
» urni ' -eflector 'he » father
getting a pillow to moving furniture to holding reflectors. When the f
“ | ‘ § oo - =4 § < I 1LCrest
feels like he is assisting he has a tendency to relax and takes a personal int

in the outcome of the images.

POSING WITH THE CHILDREN

Working with children is always a challenge. With the dynamics of the fan

S - I nee ¢ sensitve
ily changing when a new baby comes, the photographer needs to be sen
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There are those moments that make it all worth-
while, when everything comes together and the
magic happens. Here, in a split second, the child
and mother forgot where they were and expressed
their love and affection for each other. Only in a
relaxed and “safe” place can the client and sub-
Ject let go and become completely natural. When
this happens, the photographer only has to cap-

ture that moment.




Your best defense when photographing young
subjects with their pregnant mom is to position
them close to mom, establish the mother-child
connection, and make them feel that they are a
critical element in the portrait.

to any anxiety the children may be feeling. Having them participate in the ma-

ternity session can be a wonderful way to celebrate this impending change
while showing the older children how important they are to the family. Being
playful with the children will go a long way toward helping you ensure an en-
joyable session.

Toddlers and Preschoolers. Often the session will include a young child
(or multiple young siblings). The greatest challenge will be the toddler to
preschooler. Letting them feel like they are the most important part of the
portrait session will go a long way toward getting them to cooperate. For the
younger child, keeping them close to the mother and ecither embracing her
or being embraced by her may be the only means to capture the mother and
child in the same frame.

Five- to Seven-Year-Olds. Take care with little boys, and sometimes girls,
around five to seven years old. At this stage they may make silly faces when
you ask them to smile. One way to get around this is to ask them to smile
without showing their teeth or to give you a soft or little smile. Having the
little one lean against his mom’s tummy can also help to make for a calmer,
more peaceful subject and great expressions.

Older Children. When older children are to be included in a family por-

trait, it is best to handle them as adults. Pose them with the mother similar

POSING 45



to how you would pose a spouse. The difficulty lies with having the faces and

the center of attention—the expectant mother—all together in one frame.

POSING GROUPS
One way to really tell a story is to capture the emotion and relationship in a
family. With all the complex dynamics that go on in families, an effective pho-
tographer is one who can put the subjects at case and capture the interplay
of the different personalities. Taking the above-mentioned steps toward cre-
ating a relaxing, calm attitude and environment will go a long way toward
helping you capture those precious moments.

Also, by giving individual attention to each subject before and during the
session, you will establish a relationship with every family member. Take a
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This family group includes thirteen-year-g|q
triplets—and capturing them with their mothey
was a challenge. Here the solution was to place
all of the subjects as close as possible with the
mother sitting down.




Lots of coaching, talking, and encouragement
helped these children relax and elicited joyful,
sweet expressions. Sometimes, having a small
child anchor his or her head against mom can
help calm the young subject and ensure a calm,
beautiful expression. Such was the case with the

boy in this portrait.

few minutes prior to beginning the session to explain what your ideas are and
how each individual is critical to the finished artwork. This will produce an
attitude of cooperation.

To produce intimate relational images of families, the individuals will have
to be positioned closer together than is customary. Explain to your subjects—
and show them with your hands—how close they will be, emphasizing how
the finished image will look. It’s helpful at this point to joke a little with them

to break the ice and help them relax.

GAINING EXPERTISE

Learn from the Masters. One of the best avenues to gaining an under-
standing of posing and developing a cache of excellent posing ideas is to study
well-known paintings and photographs. Paintings by Leonardo da Vinci,
Michelangelo, and other prominent artists depict the human form with grace.
By seeking to replicate a simple tilt of the head or the extension of the hand
as seen in a painting, you can learn how to create a pose that will appear nat-
ural and flattering. Though posing may not come naturally to you from the
outset, as you work with your subjects and experiment, and practice your

skills, you’ll find that posing your clients will become almost intuitive.
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A second way to develop good posing technique is to study the work of

other photographers. Experienced portrait photographers establish a reper-
toire of poses that will help them to accomplish a desired look. While ob-
serving another photographer working, take notes on the subject’s st

and posture for future reference.

ance

Observe Dancers. Dancers are masters of using their bodies for self-

expression, and their grace in doing so is unmatched. Photographer Lois
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Top and bottom—One of the best ways to learn
good posing positions is to watch other photog-
raphers work with clients and models. Facing
page—Here the family was so relaxed and com-
fortable during the session that they were more
than willing to touch closely.






Greenfield is known for her strikingly beautiful images of dancers in motion.
1 3 e > g ne
If vou examine her work, you will find hundreds of examples of hand posing,

facial expressions, and body movements that w ill inspire your posing work.

Create a File. Many photographers make it a habit to browse through
magazines and catalogs in order to create a file of their favorite poses. The file
can serve as a handy reference when working with a model or subject. By
using your office copier to reduce the size of the images to fit on 3x5 cards,
you can easily store them in your camera bag, pocket, or purse and review
them when you need inspiration.

Posing Books. An obvious option for cultivating a better understanding
of the subject of posing is to consult one of the many books devoted to the
topic. Bill Hurter’s Portrait Photographer’s Guide to Posing (Amherst Media,
2004) is an excellent resource that features poses that many of the industry’s
pros favor, from classic to cutting edge. Hurter details everything from basic
posing, to posing groups, and corrective posing techniques. Professional Pos-

ing Techniques for Wedding and Portrait Photographers (Norman Phillips;

Ambherst Media, 2006) and Posing Techniques for Digital Photographers ( Jett

Smith; Amherst Media, 2005) are equally good resources.

Design Principles. Developing a feel for the shapes and visual patterns
that are considered aesthetically pleasing can also help you to make the most
of every pose and overall image composition. These principles will be dis

cussed in the following chapter.

» CLIENT TESTIMONIAL

“Wow! Jake and I were awestruck at how
amazing the pictures turned out! We can't
wait for everyone to see!”

—Stevie S.

Once you have a series of successful poses, you
can improvise and easily add images that feature
great expressions you elicit from your subjects.
In similar poses shown in this book, the male
subject is shown with a serene, contemplative ex-
pression. This portrait was made to capture the
whimsical expression and sense of anticipation

that shows on the father’s face.
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In order to create balance in this image, the cou-
ple was placed side by side. With the mother
being much smaller than the father, she was
placed both closer to the camera and in front of
him. The effect was further enhanced by ensuring
their heads were aligned and bodies were posed
in a similar direction.

5. COMPOSING THE PORTRAIT

he importance of composition in creating maternity portraits should

never be underestimated. Think of composition as a road map that view-
ers will use to reach their destination—an appreciation of the beauty of your
subject. Some of the important features of this map include the subject’s re-
lationship to another subject, to the light, and the angle of view. Also in-
cluded are the relationship between the hands, face, body, and legs of the
subject—as well as any props used in the image.

Design is similar to posing; it has to be practiced. Take the time to read
books on the topic, take a foundational class on design, study well-known
paintings, and analyze portraits created by photographers you admire. In the
beginning, take practice images with willing models. When you are working
with subjects, strive to perfect the composition—don’t allow the image to
just happen. By working on your compositions, you will also enhance your

creativity.

BALANCE

Balance is the visual aspect of an image that creates a feeling of harmony—a

sense of equilibrium and an even distribution of weight—in the composition.
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. - . A atanlv - - of the same size
A composition can feature objects that arc evenly spaced or of the sa

i i Xe iti Je ary sub
and weight. Alternatively, you can add to the composition a secondary
ject that is similar to the main subject in color or size.

. . . . = . . > - ‘ 1S
It may seem as if achieving visual balance in an mmage with two subject

with a height difference of more than a foot would prove difficult. However,

by lying the couple down, the difference in height was quickly and casily d

minished, and balance was achieved.

RELATIVE SIZE |
In a portrait of two subjects, the person who occupies the bigger portion of
the frame will draw the viewer’s gaze. The father in the image on page 51 is
physically larger. Because we w anted the belly to be the focus of the image,
we placed the mom in front of the father. In this position, she obscures much

of his large frame and gains visual prominence. The height discrepancy also

allows us to have him wrapped around the mom to suggest a sensc of unity
and protection. This helps to build the storytelling quality of the image
Though you might deduce that the largest subject in the frame will always
draw the viewer’s attention first, there is an exception to the rule: in a family
portrait of a standing woman, man, and child, the smallest subject will draw
the viewer’s eye first. You can capitalize on this phenomenon by composing
a standing image of the family so that the height discrepancy is highlighted.
This can be useful when you want to document the way the small subject is
feeling about the pregnancy and impending birth. If you want a portrait in
which the subjects are more or less equally prominent, you can scat the

mother and father and have the child stand close so that the three subjects’

heads are more closely clustered together.

RHYTHM

Rhythm is created by using repeating elements in an image. Though the por

trait above features only two subjects, the lines of their bodies create rhythm.

Note how the repetition of oval-shaped ele-
ments—the woman’s head, chest, and tummy.
and the man’s head—create rhythm in the image.
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The eye is curious about and drawn to subjects
that are not centered in the frame. An off-center
subject also leads the viewer's gaze across the
frame. In this image, the face of the mother, the
main element, is placed in a one-third area of the
image, the hands are placed in another, and the
midriff fills another.

Notice the repeating triangles formed by the mother’s arms and the repeat-

ing circular forms of the heads and belly. These rhythmic elements give the

image a sense of movement.

RULE OF THIRDS

The rule of thirds is a compositional tool long used by photographers to de-
termine the most effective subject placement. In essence, the rule states that
subjects are more visually compelling to viewers when placed one third from
any one of the outer edges (horizontally, vertically, or both) of the frame. To
ensure a more effective composition, visualize a line placed one-third from the
top of the frame and another line placed one-third from the bottom of the
frame. Next, visualize a line positioned one-third from the left edge of the
frame and another positioned one-third from the right edge. When you’re
finished, you should be able to conceptualize a tic-tac-toe grid over the image
frame. Note that there will be four points at which the vertical and horizon-
tal lines intersect; these are called power points and are thought to be excel-

lent places to position main areas of interest (¢.g., the eyes and the tummy).

LEADING LINES
Horizontal, Vertical, and Diagonal Lines. Vertical and horizontal lines
convey a feeling of motion in an image, especially when the lines form re-
peating patterns. Vertical lines represent stature and strength. Horizontal
lines represent calmness and stability. Diagonal lines can also be used in the
photographic frame to lead the viewer’s gaze to the subject. Those of us who
live in the Western world read from left to right. Therefore, as we take in an
image, we tend to start at the left edge of the frame and follow real or implied
lines in the composition to view the main subject of the image.

As you compose your image, strive to create lines that lead the eye from
the left edge of the frame, through the image, and to the subject. For in-
stance, posing your subject so that she is lying diagonally across the frame,
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with her legs to camera left, can compel the viewer to follow the line of her
legs toward her midsection, which should, of course, be prominent in the
pregnancy portrait. Angling her arm and resting her hand softly at her chin
can create another line for the viewer to follow; this one, of course, would
draw the viewer’s gaze to the subject’s face—another focal point of the image.

Note, too, that the overall position of the subject’s body, and how it re
lates to the frame, also impacts the visual flow of the image. For example, a
subject photographed lying diagonally across the frame will appear more dy-
namic than one photographed sitting upright.

S Curves and C Curves. Curved lines are also visually compelling. They
are a natural choice for drawing the viewer’s gaze through the image. A
curved line or curved subjects represent gracefulness and tranquility. Two
commonly used lines are the S curve and C curve.

The S curve is an ideal design element for composing a portrait of a preg-
nant woman. In the left-hand image (above), there is a repeating (or double)
S curve that guides the eye from the upper-left edge of the image to the
lower-right area of the frame, leading the eye to rest on the subjects’ relaxed,
content expressions. Their pose also produces a sense of rhythm and repeti-
tion. The image is full of grace and femininity, and the rolling lines add a
sense of movement to the portrait that keeps the viewer’s eye engaged.

A C-shaped curve is another natural choice when composing a pregnancy
portrait. In the right-hand image (above), the sweeping curve of the mother’s
body produces a gentle C shape. There are also C-shaped lines through the
woman’s arms, and her hands are placed gently upon her tummy in a sug-

gestion of protection, drawing our gaze to her rounded midriff.

COLOR HARMONY

Color has the power to evoke emotion and enhance the mood of an image.

The color blue, for instance, is often used to portray things as cool and re-

mote (just think of the saying, “he was feeling blue today”). Cool colors re-
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Left—The double S curve in this image creates 3

winding line through the image that draws the
viewer's gaze to the couples’ faces. Right—Note
the sweeping C curves formed by the length of
the subject’s body and in the positions of her

arms.



The color wheel.

Left—In this image, the main

near the camera and directed toward the subjects

light was placed
Along with the white clothing and background
the lighting helps to create an open, welcoming
mood for the image. Right—Moving the lighting
to the side of the subjects produced a more

thoughtful mood

cede in the frame. Warm colors tend to have the opposite effect on viewers;
they are often used to depict emotional warmth and comfort, hominess, or
passion. Warm colors visually advance in the frame.

When looking at the color wheel, we sce that greens, blues, and purples are
on one side; these are the cool colors. Yellows, oranges, and reds are on the
opposite side of the wheel; these are the warm colors.

To achieve the most beautiful image possible, you will want to coordinate
the colors in the background and clothing, ensuring that they complement
the woman and help to create the desired mood in the image. Selecting col
ors that complement the skin tones will create a feeling of warmth and har
mony. A majority of people, regardless of their skin tone, look healthy and
radiant when surrounded by earth tones. Warm tones like gold, brown,
mocha, and sienna enhance the glow of the subject’s skin. Try using gold

tulle with a mocha-colored gauze and note the impact on your subject’s skin.

SUBJECT’'S RELATIONSHIP TO THE LIGHT

['he subject’s position in relation to the light source is a factor in creating
the overall mood of the image. Light coming from the camera angle directly
toward the subject will create an open mood. Light from the side can be seen
as thoughttul, and light from behind is dramatic. Just as you use balance,
size, rhythm, and other design elements to tell the story in the image, you can
use light to compose your image. In the following three images (below and
on the following page), the direction of the light is critical to the mood es

tablished in the portraits.
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ANGLE OF VIEW

Finding a fresh and different perspective can transform a simple portrait into

awork of art. Once you place your subject in the composition, move around
your subject looking for a unique perspective to capture the image. Keeping
the basic design principles in mind, and seek out a view you would not nor-
mally capture. Moving above the subject, look down and follow the lines
of the neck, arms, and hands to the main focus of the image, the mother’s
midsection. Alternatively, you can drop down to a lower camera angle and use
the leading lines formed by the mother’s body to pull the viewer from the
bottom-left corner to the top-right area of the image. It is this creative ap-
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Note the dramatic feel of this portrait, To produce
the effect, the light was placed behind the sub-
ject. The highlights and shadows keep oyr atten-
tion focused on the tummy.



The placement and positioning in the elements in
this portrait draw the eye to the connection the

father has to the mom and baby.

proach that will take your images beyond typical portraits and into more of

a fine-art realm

TROUBLESHOOTING
When you are working with a client, take the time to step back, look over the
scene, and see if it appears balanced. It will be readily apparent when there is
a flaw in the design. Ensure that your fabric and background choices are in
harmony and make the subject’s skin appear to glow

Move the subject or move around the subject to create rhythm and re
peating shapes in the composition. Place key components of the image in the
one-third arcas of the frame. Determine where you can create an S curve or
C curve by moving the subject’s legs or arms or turning the torso the oppo
site direction from the face. Ensure that these lines and shapes pull the
viewer’s gaze into and through the frame.

Remember, the use of design elements is imperative to the success of the

image. With practice, incorporating the compositional guidelines outlined

above will become second nature.
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soft, directional light. When working in the client’s home, soft light gener
allv comes from a large window. However, all window light is not created

equal. We'll look at the qualities of good window light later in this chapter

FINDING THE BEST LIGHT

When vou arrive at the subject’s house, look for great window light. In many

homes, the master bedroom has a large window that can work well as your

main light. The larger the light source, the more diffuse the light and the

softer and more flattering the effect. A large window—10x5 feet in size and
AR 3 feet from the ground—can be ideal. At this height, the natural falloft of
the light can be used to your advantage, creating a darker area at the bottom
of the image that will help to draw the view er’s eve to the subject

Look for window light that softly illuminates the entire room. The light

should come from the environment; in other words, be sure to avoid photo
graphing a subject when the sun seems to be lined up with the window. Note,
t ft tes t too, that the llghl should come from the side of the subject (not from a sky

room. Ope i and observe the way light or through a glass ceiling). This directional lighting will wrap around the

The beautiful light from a large living room win-
dow created a perfect place to work with this ex-
pecting mother and her toddler son. After moving
through several poses and positions, this image
was captured.




Left—As evidenced in this image, the lighting
etup for this image was simple. Facing page—
To create this particular image, a backdrop was
hung, some fabrics were arranged on the floor,
ind the subjects were posed close to create a ten-
fer feeling in the image. A large window at cam-
era left served as the main light, and a reflector
placed to camera right helped to bounce light
back onto the subjects, filling in the shadows.

Left and right—Sometimes, giving the couple

some basic instructions of where to lie, and then
stepping away and not interfering, can lead to
capturing a tender moment between them. This
image was captured with a Nikon D2x at an 150 of
400 and a setting of f/3.8 at '/s0 second. The
image was retouched in Photoshop using the
Healing Brush. The Kubota Artistic Actions Vol.
Two Smoothner action and Kodak Digital GEM Air-
brush Professional c. 2.0 plug-in were used to
smooth out the skin. Finally, the image was Vi-
gnetted using Kubota Artistic Actions Vol. Two
Edge Burner action, and Nik's Midnight filter was
applied.



T




subject, creating depth and form, allowing you to achieve the desired three
dimensional quality in your portrait.

Light reflected by a white or light-colored structure morc than 15 feet
from the window can be ideal. This structure acts as a large reflector, pour
ing soft, diffuse light into the room. When working in a low light situation,
the photographer can place a large white reflector outside the window to sim
ulate the same effect and thus direct more light into the working area.

Avoid sunlight that is reflected off of a parked car, the window of another
building, or a metal structure. Colored objects outside the window (¢.g., a
house with blue vinyl siding) can affect the color of the light streaming into
the room. Your best bet in such a case may be simply to find another room
to shoot in. If this location is your best option, however, you can try to coun
teract the problem by using your camera’s custom white balance setting
and /or correcting the color cast in postproduction. Note that shooting in a
second-floor room often improves the odds that your light will be free from
the color casts that light can pick up from parked cars, grass, and other out
door objects.

Once you’ve located the ideal window light source, pe¢ ysition the camera at
a 90-degree angle to the window. The subject should be 90 degrees from the
camera angle, creating a triangle from the window, to the subject, to the cam
era. The subject then should have light falling on the side, not the front or
back. A reflector or subtractive panel should be placed on the opposite side
of the window with the subject in the middle. Again, be sure to avoid pho
tographing the subject near a window when the sun is low in the sky and

level with the window. This creates a hard light quality that will cast unwanted

dark shadows on the subject’s face.
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» MODIFYING THE LIGHT

ist day, you may need to
ide the window to direct

¢

room and another on the
ubject to bounce light

)n a bright and sunny day,
e a diffusion panel in

to soften the light

:ct for a more flattering

It is common to have limited space in a tradi-
tional home setting. Standing on a ladder in-
creased the distance between the camera and the
subject. To create this beautifully lit image, the
subject was posed facing the large master bed-
room window, and the camera was positioned be-
tween her and the light source. Note that the
positions of her arms create a graceful, visually
pleasing S curve in the composition. A Fuji
FinePix S3 Pro and an exposure of /3.8 at /w0
second at IS0 400 was used to capture the image.
Nik Software’s Midnight filter was used to en-

hance the image postcapture.




The above image was made in the couple’s master bedroom. However, the bed was too far from the win-
dow and could not be moved. Therefore, the backdrop I'd selected for the session was placed on the car-
peted floor, and complementary fabrics were added to enhance the color and add texture in the image.
The light coming through the window was very bright, so diffusion cloth was hung over the window to
soften the light. A reflector was placed directly across from the window. Note the direction of the light
and how it wrapped around the couple.

When working with window or natural light, you will find that it is necessary to work at a faster ISO
rating. Given the lack of space in most homes you will also have to use a shorter focal length lens (my
Tamron 28-75mm f/2.8 lens worked perfectly in this situation). This image was captured with a Fuji
FinePix S3 Pro camera, with an exposure setting of f/3.6 at ! /s second at ISO 400.
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7. STUDIO LIGHTING

W hen conducting the pregnancy portrait session in the studio, you can
create precisely the portrait lighting effect you’re after. This is a clear

advantage. Keep in mind that the best light is simple, soft, diffuse, and comes
from the side of the subject, rather than from overhead
When it comes to lighting a pregnant woman, your goal is to make her ap

pear as beautiful as possible, to use lighting that helps her appear slim and

shapely and caresses her features, making them as symmetrical as possible

Above—Your main goal in studio lighting should

be to create a sense of depth and dimension in
the image. The lighting should be controlled in
such a way as to illuminate and give form to the
main subject. With a softbox, such as the Norman
60-inch octagonal softbox used in this image, the
edge of the light falls off quickly, illuminating
only the subject, not the surrounding area. The
advantage of this is that the subject becomes the
focal point. This simple setup consists of a Nor-
man Monolight ML 400, a 60-inch octagonal soft-
box, and a black panel attached to a stand.
Left—With striking subjects, you can use very
dramatic lighting with a high ratio. This image
was captured with a Nikon D2x and Tamron SP AF
Aspherical XR Di LD 28-75mm f/2.8 lens. The set-
ting was f/5.6 at /25 second and an IS0 of 100.
The image was slightly retouched in Photoshop
with the Healing Brush, then enhanced with Nik's
Midnight filter. Finally, the image was vignetted
using the Kubota Artistic Actions Vol. Two Edge

Burner action.



The dramatic lighting in this portrait was well

suited to the subjects’ personalities and helped
to create the desired mood. Using a single soft-
box created the required shape and form across
the mother's midsection and the father'’s face and
arm. The father’s position was reversed, as com-
pared to the pose used in the facing-page image,
in order to show his tattoo. The portrait is more

interesting showing a piece of their personalities.

Using light that crosses the abdomen and falls off on the woman’s backside,
then turning her face back into the light can help to showcase her face to

best effect and visually slim and flatter her figure.

THE TOOLBOX
Think of your camera room, and all the lighting equipment it contains, as
your toolbox. When conceptualizing a portrait, determine the best tools for
the job. Simple lighting is often best and can allow you to focus your atten-
tion on relaxing and complimenting your subject, finessing the pose, etc.
Your basic tools are your main light, fill light (secondary light used to
lighten the shadow areas), light modifiers (softboxes, umbrellas, and other de-
vices that fit over or on your lights), reflectors (white, silver, and gold), sub-

tractive (black) lighting panels, light stands, backgrounds, and a light meter.

LIGHT RATIOS
To create the best-possible portrait, you must learn how to light your subject
in a way that flatters her form. Often, a higher light ratio will be your best
option.

A light ratio is a tool that photographers use to compare and describe the

illumination levels (the highlight and shadow) produced on each side of the
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subject. The higher the ratio, the more dramatic the difference between the

highlight and the shadow, and the greater the contrast in the image. When
the subject is evenly illuminated, there is a 1:1 ratio. When the illumination
is 2:1, the highlight side of the subject is twice as bright as the shadow side.
In images with higher lighting ratios (e.g., 3:1), there is a more profound
difference between the highlight and shadow arcas. When the shadows are
much darker than the highlights, the darker arcas of the body secem to re
cede; in other words, the subject’s form can be made to appear slimmer. Con

versely, the highlights will draw the viewer’s gaze.

In the studio, photographers use a flash meter to gauge the amount of

light emitted by their strobes. In other settings, an incident light meter read

ing, with the dome of your meter pointed at the light source, can be used to

determine the highlight to shadow ratio. ( Note: In digital ¢

apture, care should
be taken to not overexpose the highlights.)

66 THE ART OF PREGNANCY PHOTOGRAPHY

In order to give a beautifyl form anqd sha
subject and produce a three-dimensionaleﬁm

higher lighting ratio was useq to create tr;ia
image. From the highlight side of the subject t:
the shadow side there was a 3-stop difference
The approach provided an added benefit of slim:

ming the mother, with one side of her being 5
i
the shadow. i

PE to the

P CLIENT TESTIMONIAL

“Jennifer was such a pleasure to work
with. My husband and I have never taken
professional studio photos before. Jennifer
made our experience very relaxing and was
very understanding of our inexperience as
photography models. She was able to
explain the different lighting situations
that were involved with each shot. She
also had an upbeat attitude that made us
comfortable to be around her and her
camera. The photos were wonderful! We
couldn’t believe that it was us in the
photographs. My husband and I loved
every single photo she took and it was so
hard to choose which was our favorite.
We were very impressed by Jennifer's
professionalism and her talent. She has

a great eye.”

—~Celin T.






IR . . : . scribe y g style
Split Lighting. The term split lighting 1s usc d to describe a lighting

in which the main light illuminates only half of the face It’s a dramatic light

ing stvle that can be used to narrow wide faces or wide features and can bc
softened slightly when a weak fill is intre duced.

o create this stvle, move the main light lower and farther to the side of

the subject than it is used in the other lighting sty le descriptions. Sometimes,

the light may be placed behind the subject. ' his placement may be necessary
when the subject is turned far from the camera
Profile Lighting. Also called rim lighting, this dramatic lighting style 1s

used to emphasize a subject’s elegant features In this portrait sty le, the sub

ject is turned 90 degrees from the lens. The main light is placed behind the
subject to illuminate best the center of the profile and highlight the edge of
the face. as well as the hair and neck. The fill light is placed on the same side
of the subject as the main light, and a reflector is added opposite the main
light to fill in the shadows. The background light 1s placed low and behind

the subject. Adding a hair light is optional, but it can be placed on the re

flector side of the subject for enhanced separation from the bac kground

SIMULATING WINDOW LIGHT
With window light, we strive to create a feeling of depth and form Having
light from a large window to the side of the subject travel across the body and
fall away on the far side creates the form needed. With studio lighting, the
goal should be the same.

Using one light and a reflector or black panel produces a lighting ettect
that is similar to window light but with a more abrupt falloff. The beauty of
this is that the background falls into shadow, and the light is focused on the

subject, drawing the viewer’s gaze to the figure and emotion of the subject

T eate this family portrait, a 60-inch Norman
ctagonal softbox was placed at a 45 degree
angle to tt ibjects and closer to the camera

ingle. A reflector was used opposite the main
ight. Shifting the light closer to the camera angle
read the light, illuminating all the subjects.
Nith a larger group, be sure to move your main
ght to a position that covers everything. While

this may flatten the light, all subjects will be it

and the light ratio will be sufficient to create form.




This shot was
couple shot show

shot, the mon

1a

1€

Another way to create light that mimics window light is to place the main

light at a 45 degree angle to the camera, then add a small amount of fill light
with either a reflector or strobe—or ambient light. This will give a lower ratio
and less dramatic lighting, resulting in a softer, fuller look. This can be an es-
pecially good choice when photographing a family group.

To simulate window light, your light source will have to be up to four
times wider than your subject (¢.g., one that is at lcast 4 feet in width, but ide-
ally, 5-6 feet wide). Position the light to the side of the subject with a re-
flector or black panel on the opposite side. The camera angle will be from the
front of the subject, placing it at 90 degrees from the light and subject. This
lighting setup will give you the most dramatic lighting, with high lighting ra-

tios, creating form and depth.
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8. RETOUCHING AND CREATIVE EFFECTS

he digital age has changed photography forever. It is now casier than
ever to smooth out problems that might cause some pregnant women to
shy away from the camera. We can use Photoshop’s Healing Brush to refine
the client’s skin, removing blemishes that result from hormonal changes and
removing veins and other perceived flaws. We can use the | iquity filter to

slightly reshape areas that need a little finessing. By combining the power of
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Left—After slightly retouching the image with
the Healing Brush, the Nik Midnight filter was ap-
plied. Right—A touching moment can be best
represented by a simple black & white image.

Once this image was converted to black & white,
the Nik Midnight filter was added.




Bottom—

Photoshop with the wide range of dazzling eftects available through the use
of Photoshop plug-ins, we can use our artistic talents and imagination to cre-
ate unexpected fantasy images.

In the sections that follow, we’ll take a look at how a variety of images

were digitally retouched and enhanced in postproduction.

BASIC RETOUCHING OF SKIN
Digital images normally need some type of retouching, from a small amount
of sharpening to resizing the image. Below, the basic approach to retouching

will be demonstrated in several steps.

1. In Photoshop, open the original image, then duplicate the background
layer (Layer>Duplicate Layer). If necessary, sharpen your image first, flat-
ten the layer (Layer>Flatten Image), then create a new duplicate layer and
proceed to step 2.

2. Now, we’ll use the Healing Brush to remove blemishes, veins, and stretch

marks. Using a small brush, select an area with the same skin tones and
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lighting as the area to be retouched. Use the Alt/Opt key to select the
unblemished area, then click over the blemish area to remove it. The | lcal
ing Brush matches the texture and lighting of the sampled arca, giving the

blemished area a natural look.

e s e J " T - The original image, before retouching the under-

-~ i - e - -~ - 3 b Vs s

TR T oo § V8 TR - ” eye area.

The affected areas were selected using the Patch
tool.

By sliding the selected areas down to an area with
smoother skin, we were able to improve the
portrait.
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Top—The liquify filter was chosen, and a large
brush was used to nudge along the length of the
arm. Bottom left and right—Next, the Pucker
tool was used to slightly slim under and around
the chin and in the cheek area.

3. To remove or soften bags under the eyes, duplicate the layer. Using the
Patch tool, select the affected under-eye areca. With the selection made,
move the selection down to an arca with smooth skin.

4. With the selection still active, lower the opacity of the layer to around
40-60%, depending upon what gives a more natural look to the eyes. Then

flatten the image (Layer>Flatten Image).

DIGITAL SLIMMING
The liquify filter is a wonderful tool that can be used to slightly slim the arms,

under the chin, and along the body line. Here’s how it’s done:

1. In Photoshop, go to Filter>Liquify. (Make sure you are working on a flat-
tened image.)

2. Using a very large brush, select the Forward Warp tool and carefully nudge
along the length of the arm to slightly slim it. Moving to the inside of the

arm, reduce the size of the brush and nudge along the inside of the arm.

(O8]

. Using the Pucker tool, gently reduce the area under the chin, along the
chin line, and at the cheek area. Go slow and keep an eye on your results,

backing up if the correction does not look natural.

Photoshey 1o Tan image Liwr oo [Nl Vv Window e TIMWa s winw T 9
Lty 2114 copy @ 22590

Rioioos B o

T

)
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4. Moving to the midsection, vou can create the illusion of a slimmer subject
by putting a little more curve in the back. Using the Forward Warp tool
again, slightly push the curve of the back in

5. To further give the impression of a slimmer midsection, take the Pucker
tool and the Forward Warp tool to the other side of the tummy and gen

tly push in the edges.

Once the subject is retouched, you can further enhance the image using Nik

Software’s Midnight filter, as demonstrated below.

NIK SOFTWARE'S MIDNIGHT FILTER
Creating portraits reminiscent of paintings is very casy with Nik’s Midnight
filter, found in the Nik Color Efex 2.0 Stylizing Filter set. The filter softens
the edges in the image, darkens shadow areas, and lightens highlights. With
the right image, the filter can be a perfect creative tool for creating a roman
tic, moody effect.

With the filter’s contrast-altering qualities in mind. the original image was
created using a lighting ratio of 3:1, rather than the 5:1 ratio | typically favor

[ P g g . . 5 & & .

e Gt e
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Left—The forward warp tool was used to put a
e in the back for a slimmer ap-
earance. Right—The Pucker tool and Forward
Warp tool were used on the other side of the
tummy to slightly slim and enhance the body line.

This screen shot shows the original image and the

effect of applying the Midnight filter.



The final image. Note the Midnight filter's effect

on the highlights and shadows in the image.

for pregnancy portraits. The image was lighter than usual, with both the sub
ject and surrounding arca well illuminated.
Once installed, the Nik filters can be accessed via Photoshop’s Filter menu.

['o create the final image, the following steps were employed:

1. In Photoshop, the background layer of the original image was duplicated

(Layer>Duplicate Layer)

2. With the duplicate layer active, the Midnight filter was selected (Filter>nik
Color Efex Pro 2.0: Sylizing Filters>Midnight filter)
3. In Nik’s Basic palette, the following slider amounts were set: Blur = 40%,

Contrast = 15%, Brightness = 100%, and Color = 100%.

4. The Protect Highlights slider and Protect Shadows slider were both set to

50%.

5. With the settings in place, I clicked OK.

6. When the effect was complete, the image layers were merged (Layer>Flat

ten Image) and the image was saved and closed.




Though the entirety of the image shown here was treated with the Midnight
filter, you can use the settings in the Nik Selective palette to selectively apply
the effect. To do so, you can apply the effect to the overall image, as outlined
above, then use the Erase tool in the Selective palette. To do so, choose the
Erase mode, select a suitable brush size in Photoshop’s Options bar, reduce
the tool’s opacity, paint over areas that should appear slightly lighter and
sharper (e.g., the eyes and the highlights in the hair), and hit Apply. Alterna

tively, you can simply select the Midnight filter from the Selective palette, ad-
just all of the sliders in the Basic and Advanced palette as desired (see steps 3
and 4 above) and then click on the Paint button to selectively add the filter
to specific image areas. When the image appears as you desire, hit Apply. For
the majority of the images in this book, the entire image was covered except

for the eyes, lips, and sometimes hair.

BASIC RETOUCHING AND ENHANCEMENT

The steps below illustrate how making a few refinements to this touching
family portrait made for a more attractive and salable image. You can employ
these techniques to correct similar problems in your own images. Note: Be
sure to save a backup copy of all of your images before retouching them so

that you always have an original file to revert to should the need arise.

1. To remove the visible veins and blemishes from the mother’s stomach, the
background layer was duplicated (Layer>Duplicate Layer).

2. Next, the Healing Brush was used to retouch the stomach area.

3. The Clone tool, with an opacity setting of 100% was selected next, and skin
was sampled and stamped over the visible portion of the girl’s shorts. Note
that this tool can also be used to extend the background area if need be
and to add more fabric to better cover the body (or stamp skin tones over

some clothing that’s peeking out from under a tulle wrap).

@ Photoshop File Edit image Layer Select Filter View Window Help W = 4) < (0000 Tuedo6rm & O This screen shot shows two images—the final
PH e 00 e (emi )| e © samne O e o | Linger 1_’, =

portrait (left) once the retouching was complete
and the filter effect was applied, and the original
(right).
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Top—(Left) The Healing Brush was used to re

(Center) The

touch the subject’s stomach area
mother’s stomach was selected with the Lasso
tool. (Right) A layer mask was created to isolate
the woman'’s stomach. Bottom—This screen shot
shows the Nik Midnight filter Basic palette and
the settings chosen for this image.

0 | S [ e

. The stretching of the skin across the pregnant mother’s midsection re-

sulted in a slightly lighter skin tone in this area. To solve this problem, the
stomach area was isolated with the Lasso tool. With the selection active, |
clicked on the Layer Mask icon at the bottom of the Layers palette and
changed the blending mode to Multiply. The layer opacity was reduced to

57% to ensure that the stomach areca matched the rest of the woman’s skin.

. The layers were merged (Layer>Flatten image), and a new duplicate layer

(Layer>Duplicate Layer) was created.

. The last step was to enhance the new duplicate layer with Nik Software’s

Midnight filter. To create this image, settings of Blur = 51%, Contrast =
52%, Brightness = 98%, and Color = 89% were selected in the Basic filter
palette. If you desire, you can use the Advanced palette (accessed by click-
ing Advanced at the top-left corner of the Basic palette) to specify the de-
gree to which the image highlights and shadows will be protected when
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the filter is applied. For this image, those values were Protect Highlights
= 50% and Protect Shadows = 20%. Next, I clicked OK to apply the filter.
7. With the desired effects in place, the image was flattened (Layer>Flatten

Image) and saved.

NIK'S MONDAY MORNING FILTER
Nik’s Monday Morning filter (also available in the Nik Color Efex Pro 2.0 fil
ter set) is another great option for finishing an image. The following tech

nique is courtesy of Patricia Mathis, who is also the model in the image!

1. Patricia accessed Nik’s Monday Morning filter through Photoshop’s Fil
ter menu. In the Basic palette, the sliders were adjusted as follows: Grain
= 0%, Brightness = 28%, Smear = 63%, and Color = 100%.

2. Next, she clicked on the Advanced setting in the upper-left corner of the
palette. The Protect Highlights slider was set to 100%; the Protect Shad

ows slider was set to 47%. She hit OK to apply the filter effect.

Top—This screen shot shows the Basic palette

.‘“" “orn ing : 3 - for the Monday Morning filter and the settings

nik Color Etex Pro - Gl used to create the final effect. Note that the

B

orange highlight above the sliders indicates
»Basic » Advanced the range of values that will work best with
the particular image. Bottom—This screen
shot shows the Advanced palette and the Pro-
tect Highlights and Protect Shadows values

used to create this image.

,:-'Ca ncel OK

| OM| 112 4=

» Advanced

» Settings » Reset Controls
» Show More




Here’s the final image, beautifully rendered by

Nik's Monday Morning filter.

3. Patricia then created a layer mask, exposing only the eyes. She chose the
Erase mode, selected a suitable brush size in Photoshop’s Options bar,
and set the tool’s opacity to 35% to bring back some of the sharpness in
the eyes. Next, she used the same opacity setting but chose a larger brush
size to bring back some sharpness in the face. Finally, she enlarged her
brush and erased areas around the subjects’ heads to make those areas a

little sharper.

BORDER EFFECTS

Compositing a pregnancy portrait with an image of an artistic border is a
quick and easy way to change the mood and overall impact of an image. This
is one of the easiest effects to achieve, and one of the most beautiful treat-

ments. Here’s how it’s done:
1. First, we opened our beautiful natural-light maternity image in Photoshop.
2. Next, the stock border image (courtesy of Mercury Megaloudis, a promi-

nent Australian photographer) was opened.
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3. The border image was pulled on top of the pregnancy portrait and resized

using the Edit>Transform function to ensure that it matched the dimen
sions of the pregnancy portrait.

4. The Eraser tool was used at several different opacity settings to blend the
border into the image. The opacity from the outside of the border into the
image was increased so that the border overlapping the image was almost

completely erased.

FANTASY IMAGES

For expectant parents, a sonogram provides an exciting opportunity to “pre-
view” the baby in the womb. Through the technological advances that digi-
tal imaging offers, photographers can now help clients to preserve the magical
feeling that comes from catching a glimpse of the baby in the uterus. You

can use the process outlined below to create a composite portrait that super-
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Top—To composite a portrait with an artistic boy.
der photo, first open both image files in Photo-
shop. Bottom—A layer mask is created on the
border image layer, and the portrait, which lies
just below the border image, is revealed, Facing
page—Here is the final composite Pregnancy

portrait







imposes an image of the baby onto the mother’s stomach, creating a fantasy
portrait that’s highly desirable to your clients.

Photographing the Belly. When photographing the mother’s belly, be
sure to capture it at its widest point. Depending upon how the mother is car-
rying, this usually is from the front, but in the case of the twins, the best
angle may be from the side. The lighting should illuminate the main portion

of the belly but should not be so intense that detail is lost in the highlights.
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Many new parents cherish composite photos. Cre-

ating them involves importing the newborn
baby’s photo into Photoshop and working a little
digital magic.



Creating this “twins in the womb” portrait was
fairly easy. We started with a portrait that allowed
for an unobstructed view of the shape of the
tummy and then created a portrait of the twins
nestled closely as they would have been in the
uterus. To ensure the best-possible effect when
creating an image like this, you will want to cap-
ture the pregnancy at the latest date possible so
the tummy size appears appropnate for a full-
term baby (or babies). The timing can be tricky:
in this case, the session was held four weeks be-
fore the due date, since twins traditionally come

early. As it turned out, this mother went into

labor immediately after the session.

It is important to hold the texture of the skin, as this will add to the realistic
feel of the image. Lighting from the side of the subject and using a lighting
ratio of 3:1 or greater will help you sculpt the subject’s figure and enhance
the feeling of dimension in the image.

When creating an image to be used in a composite like this, take care that
the mom’s hands and any props do not cut into the view of the tummy. This
will facilitate compositing the images in Photoshop. There is one notable ex-
ception to this rule: it can be a good idea to cover the belly with a sheer,
almost transparent fabric. The fabric layer adds to the natural transition be-
tween the belly and the baby. Without the fabric, it can be difficult to achieve
a smooth transition, and the image may end up looking too contrived.

Photographing the Baby. The second component of the fantasy image is
the newborn portrait. Portraits of babies who are six days to three weeks old
seem to work best. At this age, the babies can be casily brought into the stu-

dio. Also, by this time, the mom and baby will have an established and ef-
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fective feeding pattern; this can help ensure the baby is calm, and sleepy, for

the image. A sleeping baby appears more like a baby in the womb

he fabrics used in the pregnancy session will help you determine which
fabrics to photograph the infant against. Try to photograph the baby against
a fabric that matches the mother’s skin tone as closely as possible for casier
blending once the images are combined

The casiest way to photograph the baby is to place the background fabric
over the mother, then place the newborn in her arms. Have the mother curl
the baby into a tight little ball, simulating the way the baby would appear
in the womb. Take several images from various angles. If possible, ensure that
the quality and direction of the light used in the pregnancy portrait is re
created in the image of the baby. If this is not possible, you may be able to
flip the image in Photoshop or do a little image editing to ensure the two im
ages are better matched.

In the following sections, we will review the specific strategies used to cre

ate composites.

Baby Makes Three

The portrait of the father and mother was captured at the client’s home ap
proximately one month before the baby was born. The image of the new
born was captured about ten days after birth. To create the newborn’s

portrait, we draped the mother in fabric and placed the baby in her arms.

1. Both images were opened in Photoshop.

2. A duplicate layer (Layer>Duplicate Layer) was created, and some minor
retouching was done.

3. The varied skin tones of these three subjects made the image a good can-

didate for a color to black & white conversion. To accomplish this, the
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image was flattened (Layer>Flatten Image), then the Kubota Artistic Ac
tions Vol. Two New B&W action was selected in the Actions p.\lt‘llt\ and
the eftect was applied by hitting the Play button.

. The image of the baby was flattened and resized to suit the size of the
mom’s stomach. The portrait was dragged above the layer containing the
pregnancy portrait. Next, the Eraser tool, set to various opacities, was used
to erase the fabric the baby was photographed upon. The baby was moved
into the desired position on the belly. Note how well the position of the
baby complements the position of the father’s face and expression

5. The background layer was renamed Layer 0 to unlock it so that the layer
with the baby could be dragged below the pregnancy portrait layer. A layer
mask was created on the pregnancy portrait layer, and with the Brush tool
set to black and with an opacity of 73%, the baby was revealed. ( Hint:
[ake care to reveal only what is needed to tell the story of the image.)

6. Finally, the image was flattened (Layer>Flatten Image), then the Kubota

Artistic Actions Vol. Two Edge Burner action was selected in the Actions

palette, and the effect was applied by hitting the Play button

Left—This screen shot shows the two images that will be composited and finessed to create the fantasy image. Right—This screen shot shows the image of

the baby positioned on the mother’s tummy.
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Left—A layer mask was created, and the Brush tool, set to black and an opacity setting of 73%, was used to reveal the image of the baby. Right—Adding
a vignette with the Edge Burner action was the final step required in producing this fantasy portrait.
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Facing page—The final composite image. Top—
First, both images were opened in Photoshop.
Bottom—The image of the twins was dragged
onto the photo of the mom, and the babies were
positioned on their mom’s tummy.

Twins

The maternity portrait showcased in this section was captured late in the
pregnancy. Given the size of the mom’s belly from carrying twins, it was nec-
essary to cover her tummy with fabric. After investigating several positions,
she was photographed from above with light coming from a window directly
in front of her.

The twins were photographed in their home less than three weeks after
they were born. Some babies can become very fussy during the session. Hav-
ing their mother hold them can be a problem, as they may want to nurse if
they sense that Mom is nearby. Faced with this situation during this session,
we had their grandmother sit down near a large window in the home and
covered her with a white backdrop. When the babies were asleep, they were
positioned very close together and photographed on grandma’s lap.

Both images were imported into Photoshop, and the following steps were

taken to produce the composite fantasy image.

L. Both images were opened in Photoshop.
2. The image of the babies was cropped, dragged over the pregnancy portrait

b

and positioned on the mother’s belly. The edges of the fabric around the
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Top—This screen shot shows the appearance of
the Layers palette, illustrating the steps applied
in step 3. Bottom—(Left) This screen shot shoys
the Protect Highlights and Protect Shadows ya|.
ues selected in the filter's Advanced palette,
(Right) This screen shot shows the Grain, Bright.
ness, Smear, and color values assigned in the fil-
ter’s Basic palette to create the final filter effect,

L E——————-

babies was erased using different opacity settings to create a realistic tran-
sition from the fabric under the babies to the mother’s skin.

3. The layers were renamed, and the layer containing the image of the babies
was dragged below the pregnancy portrait layer. A layer mask was applied,
and the Eraser tool, set to various opacity settings, was used to reveal the
image of the twins and to blend the areas where the two images met to cre-
ate a realistic transition.

4. Next, the image was darkened slightly in Levels, and hot spots were re-
touched with the Clone tool.

5. The Monday Morning filter was opened. In the Advanced palette, Protect
Highlights was set to 100% and Protect Shadows was set to about 50%. In
the Basic palette, the slider settings for this filter were Grain = 0%, Bright-
ness = 30%, Smear = 38% (this falls within the highlighted area of the slider,
indicating the range of values that will produce the best effects for the se-
lected image), and Color = 100%. With these settings in place, clicking
OK applied the filter.

6. Next, the image was flattened (LayersFlatten Image). To finish the por-
trait, Kubota Artistic Actions Vol. Two Edge Burner action was used. To
apply the effect, we simply selected the action in the Actions palette and
hit Play.
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Top—The Kubota Edge Burner plug-in was used
to create a vignette around the subject, which

helps to draw the viewer’s gaze to the focal point

of the image. Bottom—The final image.
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Your business cards should mirror the style and
quality of your other marketing materials and
should appeal to the demographic you're after.
Business cards created by Studio2CDesign (www

studio2Cdesign.com).

» CLIENT TESTIMONIAL

“During my first prenatal visit I saw a
beautiful photograph of my obstetrician’s
pregnant belly surrounded by her three
adoring children. I was so enchanted by
this photograph that I had to find out who
could do such amazing work. Through her
art, Jennifer George truly captures the
essence of soul and spirit. I feel very
fortunate to have found her.”

—Christine R.

858.2592533 :
www.JenniferGeorgePholggraphy.com

the type and style of your work, show a selection of your images to others and
listen to what they say. Do your studio and appearance reflect the feel of your
portrait style? The look or feel you create is considered “branding.” To sculpt
your image, consider the following questions: What sets you apart from your
competitors? What message do you want to send to the public? Why should
a mother come to you, rather than another photographer, for her maternity
portraits? Bill Chiaravalle and Barbara Findlay Schenck’s book, Branding for
Dummies (Wiley Publishing, 2006) is a great resource for developing your
business image. Power Marketing by Mitche Graf (Amherst Media, 2004) is
another indispensible book. On the Internet, be sure to check out www.small
businessbranding.com for information on sculpting your image.

Once you have a handle on what your style is, or what you want it to be,
you will want to ensure the colors, font styles, and even the size of the picces
you create reflect that style. If your style is traditional, you will want to select
standard-size postcards, subdued colors, and brochures and with classic fonts.
If your look is young and fresh, you will want to use odd-size postcards,
bright colors, and funky fonts. Keep the look cohesive and follow the color,
style, and feel throughout all your marketing pieces, including your website.
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BROCHURES AND FLYERS

Many photographers drum up interest in their pregnancy portraiture by plac
ing colorful, eye-catching brochures and flyers in local obstetricians’ and pe
diatricians’ offices. Your brochures and flyers should feature your best work
and should be updated often with new images.

When designing these materials, be sure that the text does not oy ershadow
the focal point of the marketing piece—your photography. Also, be sure that
your contact information (studio name, address, phone number, and website)
are prominently featured. Also, strive to create a brand identity. In other
words, select a font and overall layout that remains consistent from one piece
to another. Also remember to ensure that your print materials are top qual
ity. They represent you, your studio, your work, and your professionalism. It
you are not confident in your ability to design your own marketing materi
als, hire a professional designer. Quality is key. Remember, your portraits may
be award winning, but if your marketing materials don’t reflect that profes

sionalism, prospective clients won’t pursue you as their photographer.

POSTCARDS

If you distribute postcards, make them colorful and eye-catching. Say little,
show a lot! Make them tiny masterpieces. The same design elements can be
incorporated in print newspaper and magazine ads and television ads; this

will help you to build brand recognition.

i

A
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The priceless expressions and the rounded tummy
featured on this postcard will appeal to a wide
range of prospective clients. Frequently update
your postcards and other marketing materials so
that the image shown represents your current
style. Postcard by Studio2CDesign (www.studio2C

design.com)
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Mail the postcards to newlywed clients—or to all of your clients. You can

also mail them to local residents if your budget allows. Smaller studios and
more frugal owners may find that they can generate all of the business they
can handle simply by leaving the postcards in doctors’ offices, in baby furni-
ture and clothing stores, in maternity shops, on laundromat bulletin boards,
in teachers’ lounges at schools, in child pickup arecas at preschools, at La
Leche League meetings by the refreshments table, on bulletin boards in stores
near the photo supplies or baby items, in the “quiet room™ where babies are
taken during church services, at elementary school resource centers, etc. Pur-
chasing a mailing list can simplify your marketing strategy. One good source

for such lists is www.listservicedirect.com.
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web design template. Before committing to a given template, though, re
search your competitors’ sites to be sure you won’t be using the same design.

Key Elements. No matter who designs vour site, you will want to ensure
that it features some critical elements

First, make sure your images are fast-loading. Your potential clients are
not going to want to sit for a long time in front of their monitor waiting for
vour images to load. Featuring a high-impact static image can be enough to
lure viewers to enter your site. You can also consider using a loading bar along
with a static image; that gives viewers an idea as to how long it will take for
remaining images to load

Choose to showcase only your very best images. Padding the site with
extra images will draw attention away from your strongest portraits and can
steer viewers away from your site. Less is more, and it will only take clients a
few minutes to decide they like your work and want to hire you.

Make sure that the name of the studio, your address, city, and state, and
phone number are casy to find and are legible.

Online Proofing. Successful photographers know that selling your im-
ages in a face-to-face meeting yields happier clients and bigger sales. After
taking the time to develop a rapport with your clients, you owe it to them to
create an evocative, emotional presentation in which you can answer ques-
tions, explain options, and share in their joy. Post your images online only
once you've held an in-studio consultation—and for a limited time only. This
creates a sense of urgency and encourages friends and family to place orders,
even if they live across the country. Who knows? This option may also help
you to win more clients.

You might also consider offering online proofing if your pricing is struc-
tured in such a way so that the client has prepaid most of her costs prior to
buying the prints (e.g., by paying a higher session fee, prepurchasing an

album, etc.).
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TELEVISION ADS

Television advertising is cost prohibitive for most ph()l()gr.\phcr\ An excel
lent way to take advantage of the reach of television is to join w ith other busi
nesses or to partner with a television station to raise money for a nonprofit
organization. By taking on this task, you’re likely to leave viewers with a fa

vorable impression too.

WORD OF MOUTH
Word-of-mouth advertising is your best ally. A satisfied customer w ill tell oth
ers about their experience, building your client base at no cost to you.

You can offer existing clients a fabulous price break on their pregnancy
portrait or a great discount on their next session for referring an expecting

friend or family member to your studio.

KEEP THEM COMING BACK FOR MORE

Perhaps the easiest way to generate pregnancy portrait business is to get past
clients back into the studio. Make sure that all of your clients are aware of
every type of service you offer. Your wedding clients can be great repeat
clients when they decide to start a family. A first-time family portrait client
may also benefit from some pregnancy portrait information; you never know
when her family will grow. Always tell your clients about the array of sery ices

you offer. They are your walking billboards.

PORTRAIT DISPLAYS

Because pregnancy photography is such a specialized area of photography,
you cannot rely on all of the avenues you might employ to market your sery
ices to your general portrait population. One approach that works particularly
well is to ask local businesses that cater to your prospective clients if they can
devote a little of their wall space to a portrait display.

The best places to set up displays are in obstetrics and gynecology offices,
fertlity clinics, maternity shops, and any other business that caters to babies.
Some practitioners and business owners will provide the opportunity without
requiring any compensation, as your portraits can add to their decor. Others
may want to strike a trade agreement: one of my associates allows me to show
my portraits in her office in exchange for a yearly portrait session and framed
prints of her three children (you might consider offering gift certificates for
free portrait sessions that the business owners can give to loyal clients). This
particular display has brought me some of my best clients.

Creating large displays in local shopping centers or malls is another means
to marketing your work. You can rent window space from other businesses
with the same clientele or can even seck to display you work inside the store.

Do a little research to ensure that you are displaying your work in busi-
nesses frequented by your desired demographic. Renting display space can
be expensive, so you’ll want to do all you can to attract higher-end clients

with discretionary income that they are willing to spend on your portraits.
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Your unique imagery is a powerful motivator for
prospective clients to book your services. Be sure
to include some signature pieces in your product

displays.



ift Certificate
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David McKay of McKay Photography in Sacramento, CA, took the time to
seck out a mall that caters to high-income customers. After negotiating with
the mall for four years, he was able to create a beautiful display of his images
that suited the overall look of the mall environment. “The key [to making
your display work for you] is having work that is unique, different, and high
end . .. work that is different from everyone else’s and stands on its own,”

David says.
PUBLIC RELATIONS

If you find the terms “marketing” and “public relations™ confusing and as-

sume they are one and the same, you owe it to yourself to read up on the
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In a market that is saturated with PhOtographers
creating unusual and extraordinary images will se;
you apart and create an interest in your services
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power of maximizing your public relations. Eric Yaverbaum. Robert W. Bly,

[lise Benun, and Richard Kirshenbaum have written an casy-to-read, in

formative book called Public Relations for Dummies (Wiley Publishing

2006), which you can pick up for under $20.00. You’ll enjoy learning about

the many ways you can expand your client base.
Networking is a critical component of achieving name recognition. As you

will see, the photographers interviewed in chapter 9 have employed many of

these age-old techniques. Many of them regularly attend weddings, Chamber

of Commerce mixers, special interest clubs, and muscum and art gallery

openings to mix and mingle—and hand out business cards and walking cards

(small cards printed front and back with more information than a business

card but less than a brochure).
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Expressive images not only tell a story, they also

make great marketing pieces.

The importance of networking has been spoken on extensiv ely by many
successful businesspec ple. Zig Ziglar and John P. Hayes, Ph.D. have authored
Network Marketing for Dummies (Wiley Publishing, 2001), a great little book
that vou can pick up for under $22.00. In it, you’ll learn a wealth of ideas that
will help you amplify your visibility in the community. From attending civic
organization meetings, to taking on a speaking engagement for a local or
ganization, to holding your own gallery show or “mother’s tea” for young
women with small children, to displaying at the local county fair, to writing
articles on the beauty of pregnancy portraits for the local parents’ newsletter
or community newspaper, to being a sponsor on public television’s annual
auction where a buyer can donate a set amount to the PBS station and have
a sitting with you, to giving away a free sitting and an 8x10-inch portrait
through raffles conducted by the Chamber of Commerce, Rotary Club, or
mothers’ clubs—there’s no end to the public appearances you can make to
reach potential clients. As politicians know, you must meet and mingle, see
and be seen in a wide array of community events to gain recognition and win

the public’s interest.

GENERATING YOUR OWN BUZZ

The parenting and child-oriented newspapers, little neighborhood news-
papers (mostly weceklies), and the family sections of local newspapers are al-
ways looking for new stories. Consider scheduling a meeting with the editor
of one of these publications, and tell them about the growing trend of women
having their pregnancies recorded and showcased in family portrait albums.
Many editors and reporters will be surprised and pleased to interview you,
and when your story appears in print, you will be viewed as the local expert

on pregnancy p()rtmilurc.
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SALES

Many people believe that capturing images is the most important part of their
business. Of course, a photographer cannot szay in business unless they sell
their images!

There are many proofing options available to photographers and their
clients today. We’ve found that projection works best for our studio. Because
we cater to higher-end clients, we often have the option to allow our clients
to preview their images on their large-screen televisions in their own home
theaters. This seems to produce better sales than do in-studio presentation
sessions, as we can recommend particular portraits in larger sizes for display
in specific areas of the home (with a quality frame, of course) or particular
specialty products.

We first run through a slide show of the images, set to royalty-free music,
to really create an emotional response from the viewer. Then the images are
presented one by one or in small groups so the client can select her favorites
and place her order. We also recommend several add-on items, including
frames, albums, and image boxes, jewelry, and purses. ( Note: If you must,
you can send the DVD home with your clients to give them some time to
think about their order. However, this can discourage sales. If you do send
the DVD home, get a large, nonrefundable deposit, and tell the client that
the amount will be applied toward the price of their product order when they
come into the studio to place their order.)

You can also add the DVD slide show to your product line (again, you

must be sure to use royalty-free music) and offer it for sale, or offer it as a gift

with purchase if your client’s order reaches a specific dollar amount.

Projecting your images assures the biggest possi-
ble sales. Putting the images to music and show-
ing them large creates and emotional appeal for
your clients. Kim Treffinger's presentation room
(below) is decorated with samples of her work,
and products are displayed for clients to see and
touch. The rich colors used in the room create
help to create a luxurious, affluent feel. Presen-
tation room photo courstesy of Kim Treffinger,

www.treffingerstudio.com.




Photo by Parker Pfister.

10. PROFESSIONAL PERSPECTIVES

I n this chapter, we’ll take a look at some of the ways portrait photogra-
phers at the top of their field approach pregnancy portraiture. You’ll find
that many of the photographers profiled here have similar viewpoints; how-
ever, you’ll also gain an appreciation for the innovative approaches each pho-
tographer uses to personalize their work and set their business apart from the

competition.

KEVIN KUBOTA

Background. Kevin Kubota of Kubota PhotoDesign, Inc., located in Bend,
OR, is a wedding and portrait photographer who creates images that speak
to the heart. They are filled with emotion, joy, intimacy, and impact. Who
better to capture the joyful, intimate moments of pregnancy?

Kevin’s photos have been featured on the covers and pages of many pop-
ular magazines and photography books. He has been a Nikon-sponsored
speaker, and his work with the Nikon digital camera has been the focus of the
company’s advertisements. He is named in the Legends section of the Nikon
website (www.nikonnet.com) as a prominent wedding photographer. Kevin
is also a PPA Photographic Craftsman.

Kevin loves to share his Photoshop tricks and actions, and his trademark
Digital Photography Bootcamp™ seminars consistently sell out nationwide.
He is the author of Digital Photography Boot Camp (2006), published by
Ambherst Media. He is also the creator of a number of Photoshop actions that
will allow you to add beautiful portrait effects quickly and easily. For more in-
formation, go to www.KubotalmageTools.com.

Personal Satisfaction. For Kevin, the personal rewards that come from
creating pregnancy portraits are many. He loves providing the subject with a
once-in-a-lifetime image that she will cherish and hopefully pass on to the
little one inside her belly. He also gets a lot of satisfaction from being able to
photograph a woman who may feel a little large and unattractive, because
when they create a beautiful portrait, she’s so proud and excited. “I had one
client whose mother simply could not understand why she wanted pregnancy
portraits made and tried to talk her out of it. After her mom saw the images,
she loved them so much she bought many portraits herself,” Kevin says.
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Kevin also finds that his maternity portrait clients are always excited and
cager to do whatever it takes—which always amazes him considering their
condition and the fact that moving and holding positions can often be un-
comfortable. He appreciates when they are willing to go outside with him and

find a great spot to make the images. For one session, Kevin’s pregnant sub-
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For this image, Kevin's subject hiked down 3 rocky
trail, through freezing water, over logs, and out
onto a slippery riverbed to get to this spot (it was
the client’s idea)-something Kevin wouldn't ask
a pregnant woman to do unless she was com-
pletely comfortable with it. Kevin yseq a tripod-
mounted Nikon D1x, fitted with an infrared filter
and set to the black & white mode, The image was
made under an overcast sky, and the exposure was
4 seconds at f/8. Photo by Kevin Kubota,






TERRI LEE
Background. Terri owns and operates Starlight Photography in Mission
Viejo, CA. A photographic instructor, Terri has also been awarded a fellow
ship from the Professional Photographers of ( alifornia in recognition of her
service to the photographic industry. In 2004, Terr conducted a program at
the Professional Photographers of California’s Western States Convention
called “A New Life: Maternity and Newborn Photography.” In 2005, she
was named PPA’s Photographer of the Year and was awarded her Photo
graphic Craftsman degree from the same organization

When Terri first began her work as a pluh'\w'n.»\ ;\hulu:\lmﬂvu she con
centrated on wedding photography

Many of her happy bridal clients became maternity portrait clients As her
skill level and portfolio began to grow, Terri’s satisfied pregnancy portrait
clients referred their pregnant family members and friends

Other referrals have come obstetricians’ and other physician’s offices. Terri
provides local doctors with portraits that enhance their waiting rooms’ and
examination rooms’ decor in exchange for placing her marketing pieces in
the waiting rooms. The practice has provided mixed results, but it seems to

work best in offices that serve a predominance of her target market. Terri’s

business is low volume by choice, but she is always pleased when her targeted
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horn better than she can. She feels that maternity photography is an un
familiar and often scary idea for many prospective clients and that marketing
the concept works best when the sessions and images are described and ex
plained, with sample images being shown. This approach works especially
well when coupled with an enthusiastic endorsement from another client.

Because of the visual nature of the photography business, Terri feels it is
important to produce high-quality, colorful, eye catching marketing picces.
Her own materials can be found in the waiting rooms of local pediatricians’
and obstetricians’ offices and can be casily slipped into a purse while a client
is waiting for an appointment. Clients leaving her studio also take her mar
keting pieces and share them with friends and family. Word-of-mouth adver
tising is one of the most effective ways to expand the client base.

On occasion Terri attends community and charity events to mect potential
clients. She also donates services and auction items to charitable groups whose
members fall into her preferred demographic. Additionally, she recommends
speaking to interested groups, where your wonderful images can be shown
and questions can be answered in a group setting.

Without the marketing she has done, Terri feels that she would not be able
to create the work she is most passionate about—maternity and newborn

portraiture.

TIM MEYER

Background. Tim Meyer has worked as a full-time professional photographer
since 1979 and currently serves as the chairman of the portrait division at the
Brooks Institute of Photography in Santa Barbara, CA. He has achieved the

prestigious Master of Photography, Photographic Craftsman, and Certified

Professional Photographer distinctions from PPA and also holds a Master’s of

Art degree from California State University—Fullerton. He has had numer-
ous one-man exhibitions of his fine-art portraiture around the country.

Tim finds pregnancy portraiture satisfying and says, “Men have always con-
sidered a pregnant woman beautiful. It is perhaps tied to our natural feelings
as fathers and our love for the woman with whom we share the experience.
It is exciting to see how maternity portraiture has become such a large part
of the portrait marketplace and how it is appreciated by men and women
alike.”

Working with Clients. Tim finds it is more difficult for male photogra-
phers to photograph women in what approaches a “figure study” style of im-
agery. He always works with a female assistant in the studio. Not only does
that put the women at case, but it allows his female assistant to help them
with clothing adjustments. Tim notes that it is important to consult with the
client before each session to determine what style of portrait they would like
and what level of modesty is appropriate for them. Not doing so before a ses-
sion can create an awkward situation, he warns.

Tim observes that creating pregnancy portraits is very rewarding both to

the photographer and the subject. He feels there is a joy in seeing clients ex-
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cited about quality, creative photography, and that it is especially rewarding

because pregnancy portraiture is new to many clients. Tim says his clients
have told him wonderful stories about sharing their images with friends and

» PROFESSIONAL REFLECTION  family and the amazing and joyful responses they have elicited.

“It is exciting to see how maternity Technical Tips. Tim feels that a 60-80mm lens is a great choice for full-

portraiture has become such a large part ~ frame digital SLRs and says that any lens that is about 1.5 times longer than

of the portrait marketplace and how itis  a “normal” lens for a 35mm-type camera would work well.
appreciated by men and women alike.” When lighting their pregnancy portrait subjects, most photographers pre-
—Tim Meyer  fer large light sources—usually a window or a large softbox. This type of light
tends to be very forgiving and also renders the shape of the body beautifully
when it is properly used. Tim often uses soft light too but sometimes lights

mainly for the face, employing some of the more dramatic studio lighting

techniques to add impact to the portrait.
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Marketing. Much of Tim’s client base has been built up through word
of-mouth referrals from previous clients. Developing marketing relationships
with pediatricians and maternity or “mommy and me” groups has also
worked well for Tim, but he warns that you need to choose a group that
serves your target demographic. Maternity portraiture has changed and
grown dramatically over the past few years, Tim observes. Whole new gen
erations of women, older women, are having children. They are looking for
new ways to capture the emotions of that experience, and pregnancy portraits

fill that need.

GAIL PATRICE

Background. Gail Patrice of Patrice Photography of Gold River has been a
Sacramento, CA, area photographer for more than twenty-five years. Gail
trained formally at the West Coast Photography School, the Golden Gate
Photography School, and California Photographic Workshops. She later
served on the board of both the Golden Gate Photography School and Cal
ifornia Photographic Workshops. Through her work with other studios in
her early years, Gail gained a background in portraiture, wedding, and com
mercial photography.

Personal Satisfaction. The growth of Gail’s pregnancy photography spe
cialty has been gradual. At this time, maternity portraiture accounts for about
10 percent of her client base. Most of her first-time maternity clients are
women whose weddings or families Gail photographed in the past.

Gail finds photographing pregnant women very rewarding. She loves the
challenge of creating a unique image and capturing a beautiful, historic mo-
ment of a woman during this nurturing and loving stage of her life—whether
it’s their first baby or fourth! Every session is different and memorable: one
mom came to the session in labor with her fourth pregnancy, and Gail won-
dered if she was going to become a midwife!

Gail also enjoys creating couple images that feature the woman’s rounded
form. “One really big advantage of being a female photographer is that I am
comfortable with nude or seminude subjects and have my own wonderful
memories of being pregnant,” she says.

Gail notes that there is so much attention given to the mom-to-be that
the dads sometimes feel left out. “I want them to know how special they are
t00,” she adds.

Technical Tips. Gail uses only northern natural light for her maternity
portraits, which streams in through the windows of her warchouse-district
studio. (Unfortunately, there is sometimes a lack of privacy—not to mention
the distraction of loud machines and men walking by the studio!) Gail uses
white or silver panels to provide fill. She prefers simple backdrops and finds
that skin tones look rich with black backgrounds. She is constantly on the
lookout for rich, soft fabrics to wrap seminude pregnant subjects in.

Gail shoots with a Canon 20D and tends to use an ISO setting of 100 or

200 to avoid grain. She began her career using medium-format cameras and
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Photo by Eleakis Photography (Roger Ele).
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“One really big advantage of being a
female photographer is that I am
comfortable with nude or seminude
subjects and have my own wonderful
memories of being pregnant.”

—Gail Patrice

fixed lenses, and she now really enjoys the flexibility that using a digital SLR

with a zoom lens affords.

She reports that attending photography conventions, staying active in her
local PPA affiliate, Professional Photographers of Sacramento Valley, and serv-
ing as a past president of that group has helped her to make critical connec-
tions and continue her education in the field. She enjoys getting small groups
of photographers together for informal workshops, “just to fuel the passion.”

Marketing. Gail finds that her best marketing for pregnancy portraiture is
word of mouth. The majority of her clients are new moms, so they tell friends,
sisters, ctc., about their happy experience with Gail in posing for a pregnancy

photo. Gail says her clients market her!
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KIM TREFFINGER

Background. Kim Treffinger of Treffinger Studio is an award-winning, for

mally trained fine artist who lives in San Diego, CA. She is widely recognized
for her digital painting techniques and has long been known for her success,
passion, and enthusiasm across a range of artistic mediums. She was recently
featured on Home and Garden TV’s Crafters Coast to Coast and has shown
her work in Southern California and nationally. Kim is a member of PPA, a
member of and secretary for Professional Photographers of San Diego
County, and a member of the San Diego Watercolor Society and San Die

guito Art Guild. She holds a bachelor’s degree in design from the University
of California—Davis.

Personal Satisfaction. “I love a client who will put their trust in you to
be creative and still have their interest at heart in pushing the limits and try
ing something new. I love when we are having a great time together and you
just know from each successive shot that you are getting something special
for the client that they are going to love for the rest of their life,” she says.

Sometimes a client arrives feeling critical about their appearance, and Kim
is able to break through and reassure them that they are going to get some
great images they will love. It is those clients who seem to appreciate the ses
sion—and the portraits Kim creates—the most. She enjoys the creative

process of working on an image and artistically taking it to a whole new level.

Photo by Barbara Steinberg.

Kim loves working with soft, natural light. This

image was captured on the sofa in her client’s

home. Photo by Kim Treffinger.
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“There is nothing like the personal connec-

tion you get with your client when you

know you have created something really

special that they never expected.”

Photo by Teri Shevy.

—Kim Treffinger

Kim loves her job more than anything (aside from her children). “I was a
traditional painter for many years before discovering that I could combine
my painting skill with portrait photography,” Kim says. “There is nothing
like the personal connection you get with your client when you know you’ve
created something really special that they never expected. Seeing their tears
of joy when they see the images for the first time is priceless,” Kim says.

Marketing. So far Kim has been very lucky with word-of-mouth referrals,
but she is beginning to provide other professionals with gift certificates they
can offer to their clients as thank-you gifts to build her client base.

Her specialty is digital painting, and in her area there aren’t too many pho-
tographers with a fine-art painting background, so it really sets her work apart
and has allowed her business to grow relatively quickly.

Kim’s clients really enjoy her coffee-table books produced using fine-art
images from a single session or multiple sessions. She finds that once a client
sees a book she has created for another mom, they become excited about cre-
ating their own book, too.

Technical Tips. Kim shoots with a Canon 5D and tends to stick to her
24-70mm /2.8 lens. She prefers to use natural light whenever possible. She
has several Larson standalone reflectors in matte silver and shiny silver that are
used for fill.

Kim produces portraits in a variety of presentations, depending on the sub-
ject: she says black & white is a great choice that really pulls the portrait to-
gether when there are too many distracting colors or textures in the
composition. Combination black & white and color portraits are a popular
choice, and her clients also enjoy her color images warmed up with a bit of a
sepia tone.

As mentioned, Kim also creates painted portraits. She finds that it’s best to
boost the color saturation of images she plans to paint to ensure the most

authentic results.

CARL CAYLOR

Background. Carl Caylor grew up in Wisconsin and currently lives in Upper
Michigan. His studio, Photo Images by Carl, is located in Iron Mountain,
MN. He has been involved in photography for more than twenty years. He
started his career in the darkroom as a custom printer and technician, a fact
that has proven to be a great asset to his photographic and teaching career.
Carl has earned the designations of Master Photographer and Photographic
Craftsman from PPA. He has numerous Loan Collection images and has re-
ceived several Kodak Galley and Fuji Masterpiece Awards. Carl has twice been
named Photographer of the Year by the Professional Photographers of Wis-
consin. He teaches seminars from coast to coast.

Personal Satisfaction. What Carl appreciates about having added preg-
nancy photography to his repertoire is that it has created repeat business. “It
makes me part of a client’s family experiences and allows me to watch the
guests’ children grow,” Carl says. He feels that the most rewarding aspect of
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allenge of doing something unique

pregnancy portraiture is the creative ch
“We already

and artistic during a tender moment in a young family’s life.

have a tender emotion presented to us, but we need to personalize and im

mortalize it for the couple,” Carl explains.

He shares. however, that some new clients’ husbands feel uncomfortable

with the close, sometimes very personal nature of the session and images and
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Carl created this exquisitely Lit image to show the
relationship between the father and his unborn
child. Never underestimate the power of emo-
tional undertones. Photo by Carl Caylor.
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“people appear deeper in thought when

they are not brightly lit.”

Photo by John Clark.

—Carl Caylor

feels it would be casier for the men if he were a female photographer. The
mothers-to-be love the experience, though, says Carl, so he tries to include
Dad as much as possible.

Technical Tips. “If beauty were only skin deep, every photograph would
reveal the same personality,” says Carl. He feels the goal of creating a portrait
should be to produce an artistic expression that goes past the outer layer, be-
yond the first impression, and defines the subject’s essence. Artistry is a large
component in this undertaking; Carl’s philosophy is that photography is art
and family history both. He feels that, without an artistic sense, a portrait
has no longevity and will not be part of one’s family history.

Carl recommends using a longer focal-length lens, as it allows you to give
the client a little more personal space. Also, the longer lens allows for less
foreshortening of body parts, more realistically capturing the shape and form
of the mother.

Carl finds that window light is the most flattering and comfortable light-
ing option for his subjects. Since a subject’s emotions are generally on the ten-
der or soft side, he portrays the woman with the mask of her face in shadow.
“Psychologically, people are deeper in thought when they are not brightly
lit. Therefore, we want to make sure that the lighting style matches the emo-
tions we want to portray,” Carl adds.

The final presentation of the image depends on the mood that Carl and the
subject want to create. If the client is dark-haired and wearing earth tones, for
example, Carl will often create a black & white image; if the colors and the
subject’s hair are lighter in tone, the final image may be a watercolor.

Marketing. Carl says his best marketing tool is word of mouth but that a
display of images at local obstetrics and gynecology offices and displaying
pregnancy portraits in his gallery also attracts a number of new clients.

Carl notes that as a pregnancy photographer, you are creating the first im-
ages of a new generation, and as those babies grow, you can create their chil-
dren’s portraits, family portraits, senior portraits, weddings, etc. He says, “It

can’t help but grow your business.”

GIGI CLARK

Background. With four college degrees, Gigi has a varied background in-
cluding multimedia, instructional design, graphic design, and conceptual
art. She brings all of her multi-disciplined talents to her upscale wedding and
creative portrait photography business, Rituals by Design, located in South-
ern California.

Gigi has received numerous awards and honors, including several First
Place Awards in PPA and WPPI competitions and the first-ever FujiFilm Set-
ting New Trends Award. In addition, she has recently won the highly coveted
Kodak Award of Distinction. Her work and writings also appear in numerous
journals, magazines, and books. She has also earned PPA’s Master Photog-
rapher, Photographic Craftsman, Certified Professional Photographer, and

Approved Photographic Instructor designations.
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Gigi specializes in black & white photography. The fine-art quality of her
images goes far beyond mere documentation. She is highly respected by other
photographers who appreciate her style and sensitivity. Legendary portrait
photographer Monte Zucker once said, “Then there’s Gigi Clark, who’s
stopped everyone cold in their tracks. Her images are more creative than one
could imagine. With no ‘rules’ to keep her down, she consistently comes up
with great photographs!” (Shutterbug, January 2000). That review is cer-
tainly well deserved.

Personal Satisfaction. “To say pregnancy portraits changed me for the
better is an understatement,” Gigi shares. She sees capturing pregnancy im-
ages as the new frontier in portrait photography and finds it exciting that all
of the options haven’t been explored yet. Because of his “uncharted terri-
tory,” she is constantly challenged as an artist, and she lives for the ongoing
artistic challenge.

Gigi loves the challenge, however. She notes that because of the nature of
the mother’s condition, there will be cancellations and a need to reschedule
appointments, and you will need to be patient and accommodating of your
clients. Gigi has even scheduled sessions late in the game when a pregnant

mommy was due to deliver in less than two weeks!
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This portrait, entitled, In the Manner of Gauguin,
Unfinished Work, was inspired by Gauguin’s mem-
orable painting, Nevermore, a portrayal of this
thirteen-year-old mistress shortly after the birth
of their child. Gigi was captivated by the lyrical,
colorful, and symbolic meanings found in the
painting. In her version, she also took into con-
sideration the personality of the pregnant mom
and focused on her love of the sea and related el-
ements. Her final presentation is three dimen-
sional, with the image “floating” on top of the
frieze layer, much as you would when floating in
the sea. Gigi believes that an image should ex-
plore and illustrate the psychological depths of
the subject. Photo by Gigi Clark.






Marketing. Gigi discovered that a great way to reach mothers-to-be is to
network with “parallel” markets (i.e., stores where pregnant moms shop, OB-
GYN offices, etc.). She often displays “mini art shows” in obstetricians’ and
gynecologists” offices that are visually rewarding for both the doctor and the
patients. A discretely placed information “pocket™ is also included with the
display. The fine-art quality of her portraits lends them to be displayed in the
doctors’ permanent collection, and the works speak for themselves over time.
This type of marketing reaches the public in a way that is better suited to the
visual nature of our art than are bulk mailings, print ads, and in-studio dis-
plays. “The key is to restrain yourself to show only a few, highly specialized

pieces, to gain the attention of potential clients,” Gigi says.

KATHLEEN AND JEFF HAWKINS

Kathleen Hawkins and her husband and partner Jeff Hawkins operate Jeff

Hawkins Photography, a successful, fully digital high-end wedding and por-
trait photography studio in Longwood, FL. Kathleen holds her Photographic
Craftsman degree and earned a masters in business administration. She pre-
viously taught business courses for a Florida university. She has also served as
president of the Wedding Professionals of Central Florida.

Kathleen and Jeff are coauthors of Professional Marketing & Selling Tech-
niques for Digital Wedding Photographers (2nd ed.; 2006) and Professional
Techniques for Digital Wedding Photography (2nd ed., 2004 ), both published
by Amherst Media. Kathleen is the author of The Bride’s Guide to Wedding
Photography (2003), Marketing & Selling Techniques for Digital Portrait Pho-
tography (2005), and Digital Photography for Children’s and Family Portrai-
ture (2nd ed., 2008), all from Ambherst Media. Kathleen and Jeff are both
very active in the photography speaking circuit and take pride in their impact
in the industry and in the community.

Personal Satisfaction. To Kathleen, pregnancy is beautiful, and capturing
that moment in time is priceless. She says many clients feel self-conscious
about their swollen ankles and stretch marks, and that seeing the joyful ex-
pression on their faces when they realize how Kathleen and Jeff have cap-
tured their inner and outer beauty and their joy about their pregnancy is the
most satisfying aspect of pregnancy photography. “It is more rewarding than
words can express,” states Kathleen.

Technical Tips. Kathleen and Jeff always work with an assistant or make
certain someone else (husband or family member) is present during a mater-
nity session. They feel that maternity sessions are intimate, and you should
never photograph the client alone.

Like many of the other photographers profiled, Kathleen and Jeff also use
a large softbox—the Larson 4x6 Soffbox—for their studio maternity sessions.
They favor using a 70-200L f/2.8 lens or the 851 f/1.2 lens set at /8 with
their Canon 5D.

Kathleen and Jeff use sheer fabrics from www.colcandcompany.com to
wrap around the mom-to-be and create an elegant, soft background. They
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Photo by Jeff Hawkins.
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“[Pregnancy portraiture] is more rewarding
than words can express.”

—Kathleen Hawkins

also suggest that you analyze the mother’s comfort level to determine what

poses you will be able to do, and try creating a series of signature poses to
brand your portrait style and look.

Marketing. Kathleen’s marketing efforts began with the implementation
of her Lifetime Portrait Program. The program permits their wedding clients
(who receive a complimentary membership) and portrait clients (to whom
membership is available with a purchase) to receive complimentary portrait
sessions for their lifetime. Dates, times, and locations are subject to availabil-
ity and are determined at Kathleen and Jeft’s discretion. These sessions typ-
ically begin with an engagement session, then move to a wedding shoot. A
maternity session is often scheduled some time later.

Kathleen and Jeff promote their lifetime client concept by showing mater-
nity images, newborn portraits, a wedding portraits, and family portraits in
displays presented in their community.

Kathleen and Jeff also use Marathon Press’s Marketing Partnership Pro-
gram for direct mail targeted at parents-to-be within a specific income range
living within specific zip codes. With the help of their customer loyalty pro-
gram, their portrait client base increased by 28 percent in 2006, and 78 per-

cent of their wedding clients booked a maternity session.
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JUDY HOST
Background. Judy Host, owner of Judy Host Photography, located in
Danville, CA (thirty miles east of San Francisco), is one of Northern Cali
fornia’s leading portrait photographers. She has earned her Masters and Pho
tographic Craftsman degrees from PPA, and her images are included in the
association’s national exhibits. Judy has received three Kodak Gallery Awards
1999, 2000, and 2002) in recognition of her creativity and the pursuit of ex
cellence in quality. Many of her images have been exhibited at Epcot Center
and are part of a traveling loan collection
In January 2004 and 2005, Judy was selected by the Hollywood Foreign
Press to include a portrait session gift certificate in the presenter gift box for
the Golden Globes. She has photographed Jack Nicholson, Pierce Brosnan,

Nicole Kidman, Mchki Phifer, William H. Macy, Felicity Huffman. and many

other celebrities and is currently working on a journal for In Style on the
events leading up to the Golden Globes.

In January 2005, Judy traveled to Africa to photograph the presidents of
Uganda and Rwanda and several orphanages in both countries. She also tray

cled to Sri Lanka, India, and Thailand to document the progress of Tsunami

Above—Photo by Amy Cantrell. Below—This
mage was captured with a LensBaby, pointed di-

nto the window of the studio. The subject’s
very pregnant body was covered with a beautiful
green scarf with a fan blowing in her direction to
keep it from falling off. Photo by Judy Host.
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